Windows 98

The Richard Stockton College of New Jersey

This Course Covers:

• Windows basics: How to start your computer, use the mouse and keyboard, and start programs
• How to minimize, maximize, move, and switch between programs
• How to customize Windows to suit your own personal tastes.
CustomGuide.com granted to Computer and Telecommunication Services a license agreement to print an unlimited number of copies of the CustomGuide Courseware materials within Stockton College of New Jersey for training staff, faculty and students.

End users who receive this handout may not reproduce or distribute these materials without permission. Please refer to the copyright notice below for more information.
# Table of Contents

## Chapter One: The Fundamentals
- Lesson 1-1: A Look at Windows 98 and What’s New ........................................................... 5
- Lesson 1-2: Starting and Logging On to Windows................................................................. 6
- Lesson 1-3: Understanding the Windows 98 Screen ........................................................... 8
- Lesson 1-4: Using the Mouse: Pointing, Clicking, and Double-clicking............................. 10
- Lesson 1-5: Using the Mouse: Dragging and Dropping ...................................................... 12
- Lesson 1-6: Using the Mouse: Right-clicking ..................................................................... 14
- Lesson 1-7: Using the Keyboard ......................................................................................... 16
- Lesson 1-8: Exiting Windows and Turning off Your Computer .......................................... 18
- Chapter One Review ............................................................................................................ 20

## Chapter Two: Working with a Window
- Lesson 2-1: Starting a Program ........................................................................................... 22
- Lesson 2-2: Understanding the Parts of a Window.............................................................. 24
- Lesson 2-3: Minimizing, Maximizing, and Restoring a Window ........................................ 26
- Lesson 2-4: Closing a Window............................................................................................ 28
- Lesson 2-5: Moving a Window ............................................................................................ 30
- Lesson 2-6: Sizing a Window .............................................................................................. 32
- Lesson 2-7: Switching Between Windows .......................................................................... 34
- Chapter Two Review ........................................................................................................... 36

## Chapter Three: Customizing the Taskbar and Desktop
- Lesson 3-1: Moving, Resizing, and Hiding the Taskbar ...................................................... 38
- Lesson 3-2: Adjusting your Computer’s Volume ................................................................. 40
- Lesson 3-3: Adding and Removing Programs to the Start Menu ......................................... 42
- Lesson 3-4: Organizing the Start Menu ............................................................................... 44
- Lesson 3-5: Opening Recently Used Documents ............................................................... 46
- Lesson 3-6: Adding Shortcuts to the Desktop ..................................................................... 48
- Lesson 3-7: Working with the Quick Launch Toolbar .......................................................... 50
- Chapter Three Review ......................................................................................................... 52

## Chapter Four: Customizing Windows
- Lesson 4-1: A Look at the Control Panel ............................................................................. 54
- Lesson 4-2: Changing the Date and Time ............................................................................ 56
- Lesson 4-3: Adding Wallpaper to the Desktop ................................................................. 58
- Lesson 4-4: Changing Window’s Screen Colors ................................................................. 60
- Lesson 4-5: Adjusting the Screen Resolution ..................................................................... 62
- Lesson 4-6: Adjusting the Screen Color Depth .................................................................... 64
- Lesson 4-7: Using a Screen Saver ...................................................................................... 66
- Lesson 4-8: Changing System and Program Sounds ........................................................... 68
- Lesson 4-9: Using a Desktop Theme ................................................................................. 70

- Chapter Four Review ........................................................................................................... 72
Welcome to Windows 98! If you’re new to Windows, or to computers all together, you’re starting at the right chapter. This chapter covers the “bare bones” basics about learning how to start your computer and load Windows. You’ll learn how to operate the mouse by clicking, double-clicking, dragging and dropping and right-clicking. You’ll also learn about your computer’s keyboard and what those cryptic-looking keys on it are used for. Finally, you’ll learn how to exit Windows and shut your computer down.

Before we start, take a deep breath and relax. You may find this difficult to believe, but computers aren’t nearly as difficult and complicated as you probably think they are. No matter what your previous experience with computers has been, this chapter assumes you’re the most computer-illiterate person in the world and keeps everything as simple as possible. Actually, you’re probably going to find that some of the lessons in this chapter are a little too easy. When you come across something you already know how to do, go ahead and skip the lesson (unless you’re in a classroom of course—then go ahead and show everyone what a computer whiz you are!)

Ready? Did you take that deep breath? Then turn the page and let’s get started!
Lesson 1-1: A Look at Windows 98 and What’s New

Before we start pointing and clicking anything, it helps if you actually understand what exactly Windows 98 is. Windows 98 is an operating system. OK, so what’s an operating system? An operating system is a software program that controls and runs just about everything on your computer. Here’s what an operating system does:

- **Controls Your Computer’s Hardware**
  Windows controls the different devices of your computer system. It’s what makes your printer print, graphics and text appear on your monitor, and your mouse point and click… actually you make the mouse point and click—but Windows is what puts the mouse pointer on the screen and electronically connects it to your mouse.

- **Runs Your Computer’s Programs**
  Windows is what runs all your programs. Without Windows your word processor, Web browser (Internet), and games wouldn’t work. Windows lets your programs talk to your hardware, so, for example, your word processor can print things to the printer.

- **Organize Files**
  Windows stores information in files and folders on your computer’s hard disk, just like you store files and folders in a filing cabinet.

Think of Windows 98 as an orchestra conductor who makes sure all the parts of your computer—your hardware and programs—work together. Operating systems have been around for a long time—what makes Windows special is how easy it makes it to operate computers. In the computer stone age (about 10 years ago) people had to type hard-to-remember, cryptic commands into their computer to make them do what they wanted. With Windows, all you have to do is point and click to do something—much, much easier.

Microsoft introduced Windows 98 in the summer of 1998 (surprise!) So what’s the difference between Windows 95 and Windows 98? Table 1-1: What’s New in Windows 98? discusses some of the major differences.

**I already have Windows 95. Should I upgrade to Windows 98?** First, make sure you *can* upgrade. Windows 98 has some hefty hardware requirements. To use Windows 95, you...
needed a computer with at least a 486 processor, 40 MB of free hard disk space, and 16 MB of RAM. To use Windows 98 your computer should have:

- A Pentium processor
- 100 MB of free hard disk space
- 32 MB of RAM

If your computer doesn’t meet these requirements you probably need to beef-up your system before you make the switch to Windows 98. If your computer meets the minimum hardware requirements, refer to Table 1-1: What’s New in Windows 98? to see if Windows 98’s new features justify the time and cost of upgrading. If already have Windows 95, it might not be worth it.

---

**Table 1-1: What’s New in Windows 98?**

<table>
<thead>
<tr>
<th>New Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FAT32</td>
<td>FAT32 is an optimized file system that makes your hard disk faster and reduces the amount of wasted space on large hard disks. Windows 98 comes with a utility to convert your current hard drive to the FAT32 file system.</td>
</tr>
</tbody>
</table>
| Latest Hardware Support | A lot of new hardware has appeared since the introduction of Windows 95. Windows 98 includes the latest drivers to support the latest advancements in computer hardware technology. Windows 98 now includes hardware support for:  
  - USB Ports  
  - WebTV  
  - Multiple Monitors |
| Automated Maintenance | The Windows 98 Maintenance Wizard automatically performs maintenance tasks for you on a regular basis, such as defragmenting your hard disk and checking it for errors and removing unnecessary files from your hard disk to save space. |
| Programs Start Faster | The improved FAT32 file system and an improved hard disk defragmenter supposedly allow your Windows programs to start approximately 30% faster. |
| Internet Integration  | Windows 98 comes with Microsoft’s Internet Explorer 4.0 Web browser. Internet Explorer is integrated with Windows, which means you can view the contents of your computer like a Web page. This is one issue that has caused Microsoft so many legal troubles with the Department of Justice recently. |
| Windows Update via the Internet | If you’re connected to the Internet you can use Windows 98 Update feature to download and install the latest updates for Windows and your software. |
| More Reliable/ Fewer Bugs? | Microsoft claims to have fixed over 1,000 bugs in Windows 98. That, plus the support for newer hardware devices should make Windows 98 more reliable and less prone to crashing than Windows 95. |
Lesson 1-2: Starting and Logging On to Windows

When you get to work, after taking off your jacket and grabbing a cup of coffee, you probably begin your day by turning on your computer and starting Windows. This lesson explains how to do the absolutely most basic thing there is to do with your computer—turn it on. Windows should automatically start after you turn on your computer. If it doesn’t, or if a confusing-looking screen greets you, this lesson also explains what you need to do to load Windows.

1. **Turn on your computer’s monitor.**
   - The On/Off switch for most monitors is located just below the monitor’s screen. Most monitors won’t display anything until the computer is turned on.

2. **Turn on your computer.**
   - Finding your computer’s On/Off switch for the first time can be a little tricky. Refer to your computer’s reference manual if you can’t find the On/Off switch for your computer. Your computer should make a whirring sound and several clicks and/or beeps after you turn it on and as it powers up.

   **NOTE:** If nothing happens when you turn your computer on, first check the computer’s power cord—is it plugged into the wall or power strip? Check the other end of the power cord—is it securely plugged into the back of the computer? If your computer is plugged into a power strip or surge protector (it really should be) check and make sure that the power strip is turned on.

   Once your computer is turned on, one of several things will happen. Look at Table 1-2: Things That Can Happen When Windows Starts to see what you should do next.
## Table 1-2: Things That Can Happen When Windows Starts

<table>
<thead>
<tr>
<th>If This Happens</th>
<th>Do This:</th>
</tr>
</thead>
<tbody>
<tr>
<td>A dialog box appears, asking you for your user name and password, as shown in Figure 1-2</td>
<td>Actually there are two things you can do here:</td>
</tr>
<tr>
<td></td>
<td><strong>If you’re using your own computer:</strong> Type your name in the <strong>User Name box</strong> (if it is not already appear there). If you have a password move the mouse ( \rightarrow ) over the <strong>Password box</strong> click it, and type your password. Move the mouse ( \rightarrow ) over the <strong>OK</strong> button and press the left mouse button when you’re finished. Windows will create a user account for you on the computer that keeps track of your preferences and any files you work on.</td>
</tr>
<tr>
<td></td>
<td><strong>If you’re using someone’s else’s computer:</strong> Move the mouse ( \rightarrow ) over the <strong>Cancel button</strong> and press the left mouse button. Windows will start without creating a user account for you on the computer.</td>
</tr>
<tr>
<td>The Welcome to Windows 98 dialog box appears, as shown in Figure 1-4</td>
<td>Move the mouse ( \rightarrow ) over the <strong>Close button</strong>, as shown in Figure 1-4 and press the left mouse button.</td>
</tr>
<tr>
<td>The Windows desktop appears.</td>
<td>You don’t have to do anything—you can start using Windows!</td>
</tr>
<tr>
<td>An unfriendly-looking blue screen with the title “Microsoft ScanDisk” appears.</td>
<td>Opps! Someone turned your computer off without shutting down Windows (you’ll learn the procedure for shutting down Windows later in this lesson). You don’t have to do anything—just sit back and wait while the ScanDisk program checks your hard disk for any errors that might have been caused by the improper shutdown. Windows should start after ScanDisk has finished checking the hard drive.</td>
</tr>
<tr>
<td>The DOS prompt (C:&gt;) appears.</td>
<td>Type <strong>EXIT</strong> and press &lt;Enter&gt;, as shown in Figure 1-3. Your computer should load Windows.</td>
</tr>
</tbody>
</table>

If you didn’t already know how to turn your computer on, congratulations! You’ve just taken your first step in learning how to operate a computer and Microsoft Windows 98.

---

### Quick Reference

**To Start Windows**

1. Turn on your computer.
2. Refer to Table 1-2: Things That Can Happen When Windows Starts if Windows doesn’t automatically start.
Lesson 1-3: Understanding the Windows 98 Screen

The major parts of the Windows 98 screen. More items will probably appear on your computer, depending on how it is set up.

You might find the Windows screen a bit confusing and overwhelming the first time you see it. Nothing on the screen appears familiar to you—where do you even start? This lesson will help you become familiar with the main Windows screen, known as the *desktop*. There isn’t a step-by-step exercise anywhere in this lesson—all you have to do is look at Figure 1-5 then refer to Table 1-3: Major Parts of the Windows 98 Screen to see what everything you’re looking at means. And, most of all, relax! This lesson is only meant to help you get aquatinted with Windows—you don’t have to memorize anything.
Table 1-3: **Major Parts of the Windows 98 Screen**

<table>
<thead>
<tr>
<th>Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Desktop</td>
<td>The large, background area of the Windows screen. You can customize the desktop by adding shortcuts to your favorite programs, documents, and printers. You can also change the look of the desktop to fit your mood and personality.</td>
</tr>
<tr>
<td>My Documents</td>
<td>My Documents is a special folder that provides a convenient place to store files and documents you create on your computer.</td>
</tr>
<tr>
<td>My Computer</td>
<td>My Computer lets you see everything on your computer. Double-click the My Computer icon on the desktop to browse through your files and folders.</td>
</tr>
<tr>
<td>Network Neighborhood</td>
<td>If you’re on a network, the Network Neighborhood icon will appear on your desktop. You can double-click the Network Neighborhood icon to browse through the computers in your workgroup and the computers on the network. If you’re connected to the Internet, the Network Neighborhood icon will on your desktop, since the Internet is actually a network too.</td>
</tr>
<tr>
<td>Recycle Bin</td>
<td>The Recycle Bin stores all the files you delete from your computer. You can use the Recycle Bin to retrieve files you deleted by accident or empty the Recycle Bin to create more disk space.</td>
</tr>
<tr>
<td>My Briefcase</td>
<td>If you work on two computers, you can use the Briefcase to keep your files up-to-date.</td>
</tr>
<tr>
<td>Taskbar</td>
<td>The Taskbar usually appears at the bottom of your screen, and contains the famous Start button, which you use to start your programs. Whenever you open a program, document, or window, an icon for that program appears on the taskbar. This lets you see which programs are currently running and easily switch between them.</td>
</tr>
<tr>
<td>Start Button</td>
<td>The Start button lets you quickly open your programs and documents. You can also use the Start button to find files and change the settings for Windows.</td>
</tr>
<tr>
<td>Quick Launch Toolbar</td>
<td>New in Windows 98, the Quick Launch Toolbar gives you quick access to your most frequently used applications. Internet Explorer, Outlook Express, the Windows desktop, and several Web sites, called channels, are already included on the Quick Launch Toolbar by default.</td>
</tr>
</tbody>
</table>

Don’t worry if you find some of these things confusing at first—they will make more sense after you’ve actually had a chance to use them in the upcoming lessons.
Lesson 1-4: Using the Mouse: Pointing, Clicking, and Double-clicking

Just like you control your television set using a remote control, you control Windows by using the mouse and keyboard. A mouse is a palm-sized device that lets you point at, select, and move objects on your computer screen. The mouse is linked to the pointer on your computer screen—when you move the mouse on your desk, the pointer moves on the computer screen. Think of the mouse as an electronic extension of your hand. This lesson will show you how to perform the two most basic mouse actions: clicking, and double-clicking.

1. **Rest your hand on the top of the mouse, then move the mouse and watch as the arrow moves across the screen.**

   The arrow (also called the cursor or pointer) follows the mouse as you move it across the desk or mouse pad.

   **Pointing** is the most basic action you can do with the mouse. To point to something simply place the mouse pointer over it by moving the mouse. You must point to objects in order to click or double-click them.
2. Move the mouse pointer until the tip of the pointer is over the Start button. Leave the pointer there for a few seconds.

A message “Click here to begin” appears by the pointer after several seconds.

Clicking means pressing and releasing the left mouse button one time. The mouse makes a clicking noise whenever you press and release one of its buttons, hence the name clicking. The next steps will show you how to open the Start menu by clicking it:

3. Move the pointer over the Start button and then click the left mouse button.

When you click the Start button, the Windows 98 menu pops-up, as shown in Figure 1-7. Congratulations! You’ve just made your first click!

NOTE: Most mice have two mouse buttons. Normally you use the left mouse button (unless someone has changed the mouse options and reversed the buttons!) You can assume you will use the left mouse button whenever you see the words click or double-click. The right mouse button has its own purpose—and we’ll discuss it in an upcoming lesson.

You can close the Windows 98 menu without selecting anything by clicking anywhere outside the Start menu.

4. Move the pointer anywhere outside the Windows 98 Start menu and click the left mouse button.

Now that you’re feeling comfortable with pointing and clicking we’ll move on to something a little more tricky: double-clicking. Just as it sounds, double-clicking means pressing and releasing the mouse button twice in rapid succession. Normally, you open an object, such as a file, folder, or program, by double-clicking it.

5. Move the pointer over the My Computer icon and double-click the left mouse button.

My Computer opens to reveal its contents, as shown in Figure 1-8.

NOTE: A lot of people have problems the first time they try double-clicking. If your double-click doesn’t seem to work it’s probably because you’re either not holding the mouse steady while you’re double-clicking, or else you’re not double-clicking fast enough. If you click the mouse button too hard, you may inadvertently slide the mouse before you’ve finished double-clicking—and your double-click won’t register. If you’re certain that you’re holding the mouse steady while you double-click, you can adjust the double-click speed in the Windows Control Panel.

6. Close the My Computer windows by clicking its Close button, as shown in Figure 1-8.

<table>
<thead>
<tr>
<th>Click when you want to:</th>
<th>Double-click when you want to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select something.</td>
<td>Open a file.</td>
</tr>
<tr>
<td>Open a menu.</td>
<td>Open a folder.</td>
</tr>
<tr>
<td>Press a button on a toolbar or in a dialog box.</td>
<td>Display the properties or settings for an object (in certain programs)</td>
</tr>
<tr>
<td>Move to the area or field you want in a program or dialog box.</td>
<td></td>
</tr>
</tbody>
</table>
Lesson 1-5: Using the Mouse: Dragging and Dropping

You can move items around your computer screen by **dragging and dropping** them with the mouse. To drag and drop something you must: 1). Move the mouse pointer over the object you want to move, then click and **hold down** the mouse button. 2). While you are still holding the button, move the mouse where you want to place the object and then release the mouse button.

This will probably be the most entertaining lesson in the book, because your assignment is to master dragging and dropping by playing a game of Solitaire! Microsoft included Solitaire with Windows to help people improve their mouse skills. You’ve probably noticed that a lot of people never stop practicing these skills with Solitaire. Here’s how to open Solitaire:

1. **Click the Start button.**

   Remember the Start button is located in the bottom-left corner of your screen. The Windows 98 Start menu appears.

---

**Figure 1-9**
Dragging and Dropping with the mouse.

**Figure 1-10**
Starting the Solitaire game located under Programs→Accessories →Games→ Solitaire.

**Figure 1-11**
The Solitaire game, which comes with Windows.
2. **Point to the word Programs.**
   The Programs menu pops out to the right.

3. **Click the word Accessories.**
   Yikes! Another menu, the Accessories menu, pops out. (Microsoft buried Solitaire deep inside the Programs menu).

4. **Click the word Games.**
   Yet another menu pops out, as shown in Figure 1-10

5. **Click the word Solitaire.**
   You’re finally there! The Solitaire program opens, as shown in Figure 1-11

6. **Play a game of Solitaire and practice dragging and dropping the cards.**
   If you don’t know how to play solitaire, you can still practice your dragging and dropping. Just point to a card, click and hold down the mouse button and move the card around the screen. Release the mouse button, to drop the card. If you try dropping a card in an invalid location, the card will whisked back to its original pile.

7. **Click the Close button, located in the top right corner of the Solitaire program to exit the program when you’ve finished playing.**
   The Solitaire program closes.

OK, there’s got to be more things to drag and drop besides cards! Although we’ll be covering this material later on, **Table 1-5: Things you can drag and drop** shows you some examples of when you can use drag and drop.

<table>
<thead>
<tr>
<th>You can do this:</th>
<th>By dragging this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move a window to a new location on the screen</td>
<td>Drag the window by its title bar and drop it in a new location on the screen.</td>
</tr>
<tr>
<td>Move a file to a new folder</td>
<td>Drag the file and drop it in the desired folder.</td>
</tr>
<tr>
<td>Change the size of a window</td>
<td>Drag the borders or corners of the window.</td>
</tr>
<tr>
<td>Scroll a window to see something located off-screen.</td>
<td>Drag the scroll box (the little elevator) up or down the scroll bar and drop it in a new location.</td>
</tr>
<tr>
<td>Move just about anything on your computer’s screen</td>
<td>Point to the object, click and hold down the mouse button, drag the object to a new place, and then release the mouse button.</td>
</tr>
</tbody>
</table>

**Quick Reference**

**To Drag-and-Drop:**

1. Point to the object you want to drag and drop and click and hold down the mouse button.
2. While you’re still holding down the mouse button, drag the object to the desired location on the screen.
3. Release the mouse button.
You already know that the left mouse button is the primary mouse button, used for clicking and double-clicking, and it’s the mouse button you will use over 95 percent of the time when you work with Windows. So what’s the right mouse button used for? Whenever you right-click something, it brings up a shortcut menu that lists everything you can do to the object. Whenever you’re unsure or curious about what you can do with an object, point to it and click it with the right mouse button. A shortcut menu will appear with a list of commands related to the object or area you right-clicked.

Right mouse button shortcut menus are a great way to give commands to Windows, because you don’t have to wade through several levels of unfamiliar menus when you want to do something.

1. **Move the pointer over the Recycle Bin icon on your desktop and click the Right mouse button.**
   A shortcut menu appears, with a list of commands related to the Recycle Bin, as shown in [Figure 1-13](#).
2. **Point to and click the Empty Recycle Bin option on the shortcut menu with the Left mouse button.**

   You still use the left mouse button to select menu items, even if they are found in a right-mouse button shortcut menu. A dialog box appears, asking you if you are sure you want to delete the contents of the Recycle Bin. Better play it safe and…

3. **Click No with the left mouse button.**

   Next, you realize the clock displayed on the far right side of the taskbar is ten minutes fast. You can display the clock’s properties by right-clicking the clock.

4. **Move the pointer over the Clock, located on the far right side of the Windows Taskbar, and click the Right mouse button.**

   Another shortcut menu appears, with commands related to the Windows clock, as shown in Figure 1-14. Notice one of the commands listed on the shortcut menu is Adjust Date/Time. You would select this menu item if you really wanted to adjust the date and/or time your computer thinks it is. You don’t want to adjust the date or time, however, so you can move on to the next step and close the shortcut menu without selecting anything.

5. **Click anywhere outside the Clock shortcut menu with the left mouse button to close the menu without selecting anything.**

   The final object we’ll right-click in this lesson is the computer’s hard disk. To get to the hard disk you have to open My Computer. Do you remember how to do it?

6. **Double-click the My Computer icon.**

   The My Computer window opens, displaying the contents of your computer. You want to see how much space is left on your computer’s hard disk. Right-click the Hard disk (C:) icon to get this information.

7. **Right-click the Hard disk (C:) icon.**

   A shortcut menu appears, with a list of commands related to the hard disk.

8. **Click the Properties option on the shortcut menu with the Left mouse button.**

   A dialog box appears, showing a graph with how much space is left on your hard drive, as shown in Figure 1-15.

9. **Click Cancel to close the Hard Disk (C:) Properties dialog box.**

   You’re done! You’ve learned all the actions you can perform with the mouse. Quick! What are they again? Pointing, Clicking, Double-clicking, Dragging and Dropping, and Right-clicking. What an accomplishment!

---

**Quick Reference**

To Display a Shortcut Menu for Something:
- Point to the object and click the right mouse button.
- Select items from the shortcut menu with the left mouse button.

To Close a Shortcut Menu without Selecting Anything:
- Click anywhere outside the shortcut menu with the left mouse button or press the <Esc> key.
Lesson 1-7: Using the Keyboard

Now that you’ve mastered the mouse, it’s time to move on to the other device that you use to control your computer: the keyboard. The keyboard may seem more familiar and easy to use than the mouse at first, but don’t be fooled! Computer keyboards sneak in some extra keys that you need to know about. This lesson explains what these extra keys on the keyboard are and when to use them.

1. **Press and hold down the <Alt> key, press the <F4> key and release both buttons.**

   Pressing <Alt> + <F4> closes down the currently running program. Since you’re using the Windows Desktop, the Shut Down Windows dialog box appears, as shown in Figure 1-17.

   We’re not ready to shut Windows down just yet (we’ll cover that in a future lesson). Follow the next step to back out of the Shut Down Windows dialog box without selecting anything.

2. **Press the <Esc> key.**

   Pressing <Esc> does the same thing as clicking the Cancel button. The Shut Down Windows dialog box disappears and you’re back at the Windows desktop.

**Table 1-6: Special Keys and Their Functions** describes the <Alt> and <Esc> keys you just used, as well some of the other confusing keys on the keyboard.
Quick Reference

To Use a Keystroke Combination:
- Press and hold down the first key, press the second key, then release both keys. For example, press the <Tab> key while you're holding down the <Alt> key.

To Use the Special Keys on the Keyboard:
- Refer to Table 1-6: Special Keys and Their Functions.

<table>
<thead>
<tr>
<th>Key(s)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt</td>
<td>The &lt;Alt&gt; key doesn’t do anything by itself—it needs another key to make things happen. For example, pressing the &lt;Tab&gt; key while holding down the &lt;Alt&gt; key switches between any programs that are currently running.</td>
</tr>
<tr>
<td>Ctrl</td>
<td>Just like the &lt;Alt&gt; key, the &lt;Ctrl&gt; doesn’t do anything by itself—you need to press another key with it to make things happen. For example, pressing the &lt;X&gt; key while holding down the &lt;Ctrl&gt; key cuts whatever is selected.</td>
</tr>
<tr>
<td>F1</td>
<td>The &lt;F1&gt; key is the help key, and pressing it displays helpful information about what you’re doing.</td>
</tr>
<tr>
<td>Esc</td>
<td>The &lt;Esc&gt; (Escape) key is the “Wait, I’ve changed my mind” key and is the same as clicking Cancel in a dialog box. For example, if you click something and an unfamiliar dialog box appears you can close it by pressing the &lt;Esc&gt; key.</td>
</tr>
<tr>
<td>Enter</td>
<td>The &lt;Enter&gt; key is the “Carry out my orders” key and is the same as clicking the OK button in a dialog box. For example, after you’ve typed the name of a program you want to run in a dialog box, press &lt;Enter&gt; to run the program. The &lt;Enter&gt; key also adds a new line or paragraph if you’re entering text.</td>
</tr>
<tr>
<td>Tab</td>
<td>When you’re in a dialog box, pressing the &lt;Tab&gt; key moves to the next field. When you’re in a word processor the &lt;Tab&gt; key works just like you’d think it would and jumps to the nearest tab stop whenever you press it.</td>
</tr>
<tr>
<td></td>
<td>The arrow keys move your computer’s cursor across the screen.</td>
</tr>
<tr>
<td>Del</td>
<td>Nothing surprising here. The &lt;Delete&gt; key deletes or erases whatever you select—files, text, or graphical objects. If you’re working with text, the &lt;Delete&gt; key erases characters to the right of the insertion point.</td>
</tr>
<tr>
<td>Back</td>
<td>Use the &lt;Backspace&gt; key to fix you typing mistakes—it erases characters to the left of the insertion point.</td>
</tr>
<tr>
<td>Home</td>
<td>The &lt;Home&gt; key jumps to the beginning of the current line when you’re working with text.</td>
</tr>
<tr>
<td>End</td>
<td>The &lt;End&gt; key jumps to the end of the current line when you’re working with text.</td>
</tr>
<tr>
<td>Page Up</td>
<td>The &lt;Page Up&gt; key moves up one screen.</td>
</tr>
<tr>
<td>Page Down</td>
<td>The &lt;Page Down&gt; key moves down one screen.</td>
</tr>
</tbody>
</table>
Lesson 1-8: Exiting Windows and Turning off Your Computer

At the end of the day, when you’ve finished using your computer, you need to shut down Windows before you turn your computer off. Shutting down gives Windows a chance to tidy up after itself, saving information in the computer’s memory to the hard disk, cleaning up temporary files, and verifying that you’ve saved any changes you’ve made to any files you’re working on.

Should I turn my computer off at all? One of the great computer debates is whether you should turn your computer off at all. Some people turn off their computer whenever they’ve finished working on it, just like a television set. Others don’t turn their computers off—ever. People who turn their computers off at night say that keeping the computer on 24 hours a day, 7 days a week wears out the computer’s mechanical components and wastes electricity. Other people say that leaving your computer on keeps temperature fluctuations down, which is better for the computer’s delicate internal components. Plus most new computers enter a standby or hibernate mode after a period of time, so they don’t really consume that much power. Which method is best? That’s a decision you’ll have to make on your own. Some people turn their home computer off when they finish using it and leave their office computer on 24 hours a day.

Whether or not you turn your computer off or not, you should always follow the next few steps at the end of the day, when you’ve finished using your computer.

1. **Save all your work and exit all your programs.**
   Saving any files you’ve been working on is the most important step when you shut down your computer. You should also consider backing up any vital information if you have a tape backup, Zip drive, or other backup device. You can also save any important files to a floppy.
2. **Click the Start button.**  
The Start menu appears.

3. **Click the Shut Down option from the Start menu.**  
The Shut Down Windows dialog box appears, as shown in [Figure 1-18](#).

4. **Make sure the Shut down option is selected and click the OK button.**  
The computer’s hard drive hums as Windows cleans up and shuts itself down.

**NOTE:** Leaving nothing to chance, Windows checks to make sure you’ve saved everything you’ve been working on, such as letters you’ve created in your word processing program. If Windows notices you haven’t saved a file, it asks if you want to save the changes you’ve made to the file before it completes the shut down procedure.

After a minute or two, Windows finishes shutting down and tells you it’s safe to turn off your computer, as shown in [Figure 1-19](#).

5. **Turn your computer and monitor off.**  
This final step is optional if you adhere to the “Never turn your computer off” philosophy.

Congratulations! You’ve completed the chapter and are well on your way to mastering Windows 98! You’re probably wondering “What were those other Shut Down options for?” Table 1-7: Shut Down Windows Options explains them:

<table>
<thead>
<tr>
<th>Shut Down Option</th>
<th>What it Does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stand by</td>
<td>Use Suspend if you have a laptop and are going to leave your computer briefly but want to conserve as much energy as possible while you are away. After you return your computer to its original running state, you will be able to pick up exactly where you left off. (Make sure you save everything you were working on first!)</td>
</tr>
<tr>
<td>Shut down</td>
<td>Use this option if you want to turn your computer off. It saves your Windows settings and saved any information stored in memory to the hard disk.</td>
</tr>
<tr>
<td>Restart</td>
<td>Saves any Windows settings, writes any information stored in your computer’s memory to the hard disk, and restarts your computer. Use this option if Windows or your Windows-based programs start acting flaky. You often have to restart your computer after installing new software.</td>
</tr>
<tr>
<td>Restart in MS-DOS mode</td>
<td>Starts your computer in MS-DOS mode. MS-DOS mode is used to run finicky older programs, such as MS-DOS games, that will not run under Windows. When you are finished using MS-DOS mode, type EXIT or WIN to return to Windows.</td>
</tr>
<tr>
<td>Close All Programs And Log On As A Different User</td>
<td>This option appears only if your computer is connected to a network. This option closes all your programs and disconnects your computer from the network, preparing your computer to be used by someone else.</td>
</tr>
</tbody>
</table>
Chapter One Review

Lesson Summary

Starting and Logging On to Windows

- Turn on your computer, if necessary enter your user name and password, and click OK.
- To start Windows from the MS-DOS prompt (C:\>) type EXIT and press <Enter>.

Understanding the Windows 98 Screen

- Be able to identify the main components of the Windows screen.

Using the Mouse: Pointing, Clicking, and Double-clicking

- **Point**: Move the mouse so that the pointer (⿷) is over the object.
- **Click**: Point to the object and press and release the mouse button.
- **Double-click**: Point to the object and rapidly click the mouse button twice in rapid succession.

Using the Mouse: Dragging and Dropping

- **To Drag-and-Drop**: Point to the object you want to drag and drop and click and hold down the mouse button. While you're still holding down the mouse button, drag the object to the desired location on the screen, and then release the mouse button.

Using the Mouse: Right-clicking

- **To Display an Object's Shortcut Menu**: Point to the object and click the right mouse button. Select items from the shortcut menu with the left mouse button.
- **To Close a Menu without Selecting Anything**: Click anywhere outside the shortcut menu with the left mouse button or press the <Esc> key.

Using the Keyboard

- **To Use a Keystroke Combination**: Pressing one key while holding down the other key. For example, press the <Tab> key while you're holding down the <Alt> key.

Exiting Windows and Turning off Your Computer

- **To Shut Down Windows**: Save any files you've been working on, exit all your programs, click the Start button, select Shut Down, select the Shut Down option and click OK.
Quiz

1. Microsoft Windows is a (an):
   A. Word processing program
   B. Database program
   C. Operating System
   D. Graphics program

2. Windows uses only the left mouse button (True or False?)

3. Which of the following moves the pointer to another location on-screen?
   A. Pressing the arrow keys on the keyboard.
   B. Moving the mouse until the pointer points to that spot.
   C. Moving the mouse until the pointer points to that spot and click the left mouse button.
   D. Moving the mouse until the pointer points to that spot and click the right mouse button.

4. A keystroke combination is:
   A. Pressing two or more keys at the same time, for example pressing the <Shift> and <Tab> keys at the same time.
   B. A way to lock your computer to prevent unauthorized access. To unlock the computer, simply retype your keystroke combination.
   C. Using the keyboard in conjunction with the mouse.
   D. A type of mixed drink.

5. To display a shortcut menu for an object, do the following:
   A. Point to the object and press <Ctrl> + <P>.
   B. Touch the object on-screen with your finger.
   C. Click the object.
   D. Right-click the object.

6. The <F1> key displays help on whatever you’re working on (True or False?)

Homework

1. Turn on your computer and start Windows 98.
2. Find, point to, and click the Start button, then close the Start menu without selecting anything.
3. Find and double-click My Computer.
4. Shut down Windows by selecting Shut down from the Start menu, verifying the Shut down option is selected, and clicking the OK button.

Quiz Answers

1. C. Microsoft Windows is an Operating System.
2. False. Windows uses both the left and right mouse buttons.

3. B. Move the pointer by moving the mouse until the pointer points to that spot.

4. A. A keystroke combination is when you press two or more keys at the same time, for example <Shift> + <Tab>.

5. D. Right-click the object.

6. True. Pressing the <F1> key displays help on whatever you’re working on.
Chapter Two: Working with a Window

Chapter Objectives:

• Starting a program
• Understanding the parts of a window
• Minimizing, maximizing, and restoring a window
• Moving and closing a window
• Changing the size of a window
• Switching between several programs

No doubt about it, computers are sophisticated, complex machines. To make computers easier to use, Microsoft designed Windows to work like you do when you’re sitting at a desk. When you work at your desk, you spread out everything, grab a piece of paper and work on it for a while, and then shuffle another piece of paper on top of it. That’s how Windows works, except instead of working with papers, you work with windows—boxes that contain programs and information.

You can shuffle these windows around the screen, just like you shuffle papers on your desk—which is why the main Windows screen is called the desktop. Just like your desk, if you’re working with a lot of things at the same time, the Windows desktop can become messy and difficult to find things.

This chapter explains how to manage the windows and programs on your screen. First, you’ll learn how to open a window. Next, you’ll discover the parts that constitute a window (the windows on your computer are A LOT different than ones on your house). Then you’ll learn how to change the size of a window—minimizing it to a tiny little icon that appears only on the Taskbar and maximizing it so that it fills the entire screen. You’ll also learn how to “shuffle” windows around, sending some to the background and bringing others up to the forefront. Let’s get started!

Prerequisites

• How to start and shut down Windows.
• How to use the mouse to click, double-click, drop-and-drag, and right-click.
Lesson 2-1: Starting a Program

To do just about anything with your computer, you need to run a program. A program is a complex set of instructions that tells your computer how to do something. Your word processor is a program and so is the Solitaire game that comes with Windows. The easiest way to start a program is by clicking the Windows Start button and then selecting the program from the Programs menu. This lesson explains one of the most basic operations you can do with Windows: starting a program.

1. Click the Start button.
   Remember that the Start button resides in the bottom-left corner of the computer screen. The Start menu pops up.

2. Point to the word Programs.
   A menu listing the different program categories pops out to the side of the Start menu, as shown in Figure 2-1.

3. Point to the word Accessories.
   Another menu, the Accessories menu, shoots out from the Programs menu, as shown in Figure 2-2. The program you want to load, called “WordPad”, is located here, in the Accessories menu. Can you find it?

Any programs that are currently running appear as icons on the taskbar.
4. **Click the word WordPad.**

The WordPad program appears onto the screen in its own window, as shown in Figure 2-3. WordPad is a simple word processing program that is included with Microsoft Windows.

**NOTE:** The Programs menu is merely a list of the programs that should be available on your computer. Normally when you install a program onto your computer, it adds itself to the Start menu. Occasionally, old MS-DOS programs or programs that are poorly written may not put themselves on the Start menu when you install them, and you will have to find and add the program to the Program menu yourself. You’ll learn how to manually add programs to the Start menu in an upcoming lesson.

Great! You’ve just started your first program. Turn the page and we’ll examine the parts of the WordPad window.
Lesson 2-2: Understanding the Parts of a Window

Located in every window are several little buttons, menus, and controls that you use to control the program and window. There’s no getting around it—you’re simply going to have to learn what these little buttons, menus, and controls are and how to use them are because they appear in every Windows program. Here’s the good news: once you can find your way around a window for one program you’ll be familiar with the windows for most programs, since this window/menu/button concept appears in just about every Windows program.

No exercises or homework for you in this lesson—it’s just here to help you become familiar with the parts of a Window. All you have to do is look at Figure 2-4 and then refer to Table 2-1: Parts of a Window to see what everything you’re looking at is.

You’ll actually get a chance to use some of these buttons and menus later on.
Table 2-1: Parts of a Window

<table>
<thead>
<tr>
<th>Part</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title bar</td>
<td>Displays the name of the program or window.</td>
</tr>
<tr>
<td>Minimize button</td>
<td>Minimizes a window, hiding it from your screen but keeping it running in your computer’s memory, ready for quick use. You can minimize a program you’re not using so that it is still running, but out of sight.</td>
</tr>
<tr>
<td>Maximize/Restore button</td>
<td>Depending on the size of the window, this button toggles between maximize and restore. Here’s what each one does:</td>
</tr>
<tr>
<td></td>
<td>![Maximize] Enlarges the window so that it fills the entire screen. This lets you see more of the contents of the window. The Maximize button only appears when the window isn’t maximized, or doesn’t fill up the entire screen.</td>
</tr>
<tr>
<td></td>
<td>![Restore] When a window is maximized, or fills up the entire screen, clicking the Restore button returns the window to its previous size.</td>
</tr>
<tr>
<td>Close button</td>
<td>Closes the window or program when you’ve finished working with it, removing from the screen and the computer’s memory.</td>
</tr>
<tr>
<td>Menu</td>
<td>Controls what the program does. The items listed on the menu change from program to program, but the menu’s location doesn’t—it’s always perched near the top of a window, right below the Title bar.</td>
</tr>
<tr>
<td>Toolbar</td>
<td>Some (but not all) windows and programs have one or more toolbars, which contain buttons you point to and click to access frequently used commands.</td>
</tr>
<tr>
<td>Main Window or Document Area</td>
<td>This is where all the action takes place—where you work on whatever you’re working on. If you were using on a word processor, this is where your letter would appear; if were browsing the Internet, this is where the Web pages would appear.</td>
</tr>
<tr>
<td>Scroll bar</td>
<td>Sometimes a window is not large enough to display all the information at once. When this happens, you use the scroll bar to move or scroll through the information in the window.</td>
</tr>
<tr>
<td>Status bar</td>
<td>Displays information such as instructions, messages about the state of the computer, or your location in the window.</td>
</tr>
</tbody>
</table>

Got everything down? Don’t worry if you don’t—remember this lesson is just quick-guided tour of a typical window. The rest of the lessons in this chapter focus on how to use a window’s controls, buttons, and menus.
Lesson 2-3: Minimizing, Maximizing, and Restoring a Window

One of the benefits of Windows 98 is that it enables you to open and work with several programs at the same time. To make working with several programs at once easier, you can change the size of the windows. You can maximize or enlarge a window so it takes up the entire screen, minimize or reduce a window so that it only appears as a button in the Windows taskbar, or size a window somewhere in between. This lesson explains how to change the size of a window by maximizing, minimizing, and restoring.

First let’s look at how to maximize a window. Some programs, such as word processors and Web browsers, are easier to work with and see if they fill the entire screen. To enlarge a window to fill your computer screen, you click the Maximize button.

1. Click the WordPad window’s **Maximize button**—the middle button in WordPad’s titlebar.

The WordPad program maximizes, filling the entire screen. You can change a maximized window back to its original size by clicking the Restore button. The Restore button appears in place of the Maximize button whenever a window is already in a maximized state.
2. Click the WordPad window’s **Restore button** to restore the WordPad window back to its previous size.

   The window returns to its previous size.

   Just like you can keep several papers on top of your desk, Windows can run more than one program at a time. For example, you can work on a letter with your word processing program while your Web browser is open and downloading a file from the Internet. There is a potential pitfall with running several programs simultaneously—there isn’t enough room for them all to fit on your computer screen!

   Luckily, you can tuck programs away, keeping them running and ready for use but away from view by **minimizing** them.

3. **Click the WordPad window’s Minimize button** to minimize the WordPad program.

   The WordPad program shrinks to an icon located in the Windows taskbar. WordPad is still open and running—it’s just hidden from view, tucked away and ready for future use. It’s important to note that minimized programs can still run in the background, meaning if a program’s doing something, such as downloading a file from the Internet, it will keep doing it even when the program is minimized.

   It’s easy to redisplay a minimized program or window when you’re ready to use it again. Here’s how:

4. **Find and click the WordPad icon in the Windows taskbar.**

   The WordPad program springs back to life and appears on the screen.

   It’s important that you get all this maximize/minimize/restore stuff down because it will help you run more than one program at a time and be more productive with your computer.
Lesson 2-4: Closing a Window

When you’re finished working with a window or program, you can close it to remove it from the screen and computer’s memory. You can close any window or program by clicking its close button—the little close button that appears in the upper-right corner of the window.

1. **Click the WordPad window’s Close button.**
   The WordPad program closes. Notice the WordPad icon no longer appears in the Windows taskbar at the bottom of the screen. That’s all there is to closing a window or program.

   Here’s a tip: If a program has more than one window open, you can close all its open windows by holding down the <Shift> key when you click the close button for any window.

   Since you’re going to be working with the WordPad program in the next few lessons, you will need to open it again.

2. **Click the Start button.**
   The Windows 98 Start menu appears.

3. **Select Programs → Accessories → WordPad from the Start menu.**
   The WordPad program reappears.

   If a program happens to be minimized, you need to restore it by clicking its icon on the taskbar before you can see and click the window’s close button.

---

**Quick Reference**

To Close a Window:
- Click the window’s close button (X).
- Right-click the program’s icon on the task bar and select Close from the shortcut menu.
- Press <Alt> + <F4>.

To Close All Open Windows:
- Hold down the <Shift> key while you click the close button (X) of any window.
Lesson 2-5: Moving a Window

1. Position the mouse pointer over the title bar of the WordPad program. Remember that the title bar is at the very top of a window or program, and displays the name of the program or window.

2. Click the title bar and move the mouse while still holding down the mouse button. Yep, it’s that drag and drop stuff you learned earlier. An outline of the window follows your mouse as you drag the window, as shown in Figure 2-11 showing you where you are moving it.

3. Release the mouse button to drop the window to a new location.

Figure 2-11
Moving a window to a new location on the screen.
Lesson 2-6: Sizing a Window

If you’ve been following the lessons in this chapter carefully, you should already know how to change the size of a window or program by minimizing, maximizing, and restoring it. This lesson explains how you can fine-tune the size of a window to meet your own specific needs.

1. **Make sure the WordPad program appears as a window and doesn’t fill the entire screen.**
   
   A window must not be maximized (fills up the entire screen) or minimized (appears only as a button on the Taskbar) if you want to manually size it.

2. **Position the mouse pointer over the right edge of the WordPad window, until it changes to a →.**
   
   The two arrows point in the directions that you can drag the window’s border; in this case, left or right. Had you positioned the pointer over the top or bottom of the window, the pointer would have changed to a ↑ or ↓, indicating that you could drag the top or bottom of the window up or down.

   **NOTE:** Windows is very picky where you place the pointer, and sometimes it can be tricky finding the exact spot where the pointer changes. It’s there—just move the pointer slowly over the border until you find it.

3. **Click and hold down the left mouse button and drag the mouse to the right one-inch to move the window border.**
   
   Notice the window’s border follows as you drag the mouse. When the window is the size you want, you can release the mouse button.

4. **Release the mouse button.**

   The window is displayed in the new size.
This lesson explained how to resize a window by adjusting the right edge of a window, but you can also change a window’s size by dragging its left, top, and bottom. You can also resize a window by dragging its corners just like you drag its edges.
Lesson 2-7: Switching Between Windows

You can have several programs or windows open and running simultaneously, but you can only work in one window at a time. The window you’re working with is called the active window and always appears on top of any other windows that you have open. If you think about it, you do the same thing when you work at your desk. When you want to work on a piece of paper, you place it on top of everything else on your desk.

This lesson explains how to switch between the programs you’re running. There are actually several ways to switch between windows, and we’ll cover all of them in this lesson. First, you need to make sure you have several programs running…

1. Make sure the WordPad program is still open.
   The WordPad program should still be up and running from the previous lesson. If it isn’t, open it by clicking the Start button and selecting Programs → Accessories → WordPad. Notice an icon for the WordPad program appears on the taskbar. Next, you need to open another program that comes with Windows 98—the calculator.
2. Start the calculator by clicking the Start button and selecting Programs → Accessories → Calculator.

The calculator program appears in front of the WordPad program. An icon for Calculator program also appears in the taskbar, next to the WordPad icon. Notice the Calculator icon is pressed down; indicating it is the active window, or the window that appears in front of the others. You can make WordPad the active window by clicking its icon on the taskbar.

3. Click the WordPad button on the taskbar.

The WordPad program appears in front, and its icon on the taskbar depresses, indicating it is now the active window. You can also switch to a window by clicking any part of the window that you can see.

4. Click any portion of the Calculator window.

If you can’t see the Calculator window at all, it’s because the Calculator window is completely covered by the WordPad window, in which case you will have to click the Calculator icon on the taskbar instead.

Yet another method of switching between windows is the most famous keystroke combination in Windows: <Alt> + <Tab>.

5. Press and hold down the<Alt> key, press and release the <Tab> key but not the <Alt> key!

The task window appears, as shown in Figure 2-15 The task window lists all the windows and programs that are currently running. Move on to the next step to see how you can retrieve a program or window from the task list.

6. While still holding down the <Alt> key, press and release the <Tab> key until the WordPad program is selected, then release the <Alt> key.

When you release the <Alt> key the selected window or program is activated and displayed in front of any other windows.

NOTE: <Alt> + <Tab> is especially useful when you use programs that fill the entire computer screen, such as MS-DOS programs and some games. When you can’t see the taskbar or any part of another window, <Alt> + <Tab> is the only way you can to switch between programs.

NOTE: When you’re working with multiple programs, be careful you don’t accidentally run a second copy of the same program. This wastes memory and makes things confusing. For example, if you’ve been using the Calculator program and want to bring it back up, make sure you check the taskbar to see if it’s already running. If it is (a Calculator icon appears on the taskbar) use any of the methods you’ve learned in this lesson to switch to it. If a program is already running and you load it again from the Start menu, a second copy of the program opens and two icons for the programs will appear on the taskbar.

Think you have a handle on switching between programs and windows? Good, because when you work with Windows, you’ll find yourself switching between programs and windows throughout the day.
Chapter Two Review

Lesson Summary

Starting a Program
- Start a program by clicking the Start button, pointing to the Programs menu, clicking the menu and any submenus where the program you want to run is located, and then clicking the name of the program you want to run.

Understanding the Parts of a Window
- Be able to identify a window’s title bar, menu, minimize, maximize, and close buttons.

Minimizing, Maximizing, and Restoring a Window
- Maximize a window so that it fills the entire screen by clicking its Maximize button or by double-clicking its title bar.
- Restore a window to its previous size by clicking its Restore button or by double-clicking its title bar.
- Minimize a window so that it only appears as an icon on the taskbar by clicking the window’s Minimize button.
- Restore a minimized window by clicking its icon on the taskbar.

Closing a Window
- Close a window by clicking its close button or by pressing <Alt> + <F4>.
- Close all open windows by holding down the <Shift> key while you click the close button of any window.

Moving a Window
- To Move a Window: Click and drag the window by its title bar. Release the mouse button to drop the window in the desired location on the screen.

Sizing a Window
- To Change a Window’s Size: Point at the window’s edges or corners, until the pointer changes to a double-arrow (like ←→). Click and hold down the mouse button and drag the edge or corner to a new location, until the window is the size you want.

Switching between Windows
- You can only work on one window at a time. The window you’re working on is the active window, and appears in front of all the inactive windows.
• **To Switch between Open Programs:** There are three ways to switch between open programs:
  1. Click the program’s icon on the taskbar.
  2. Click any part of the window you want to appear on front.
  3. Press and hold down the `<Alt>` key and press the `<Tab>` to display the task list. Press the `<Tab>` key until the program you want is selected, then release the `<Alt>` key.

---

### Quiz

1. **To start a program in Windows 98, do the following:**
   A. Make sure the Program Manager is open, double-click the Program Group where the program you want to run is located, and double-click the Program.
   B. Click the Start button, point to the Programs menu, click the menu and any submenus where the program you want to run is located, and click the name of the program you want to run.
   C. Click the Start button, point to the Run menu, click the menu and any submenus where the program you want to run is located, and then click the name of the program you want to run.
   D. None of the above.

2. **The little bar that lists a program’s name and is found at the top of a window is called the:**
   A. Windows bar.
   B. Program bar.
   C. Title bar.
   D. Very top of the window bar.

3. **You start your favorite word processing program to type a letter, but the program appears in a window that’s too small to use. How can you maximize the window so that it fills the entire screen? (Select all that apply).**
   A. Select Window → Full Screen from the menu.
   B. Double-click the window’s Title bar.
   C. Click the program’s icon on the taskbar.
   D. Click the Maximize button located in the right side of the window’s Title bar.

4. **You can open or restore a minimized window by clicking its icon on the taskbar** (True or False?)

5. **You can move a window to a different position on your computer screen by dragging it by its:**
   A. Title bar.
   B. Status bar.
   C. Move handle.
   D. Tail.
6. You have several programs open at the same time—how can you switch between these programs? (Select all that apply).

A. Restart the program—Click the Start button, point to the Programs menu, click the menu and any submenus where the program you want to switch to is located, and click the name of the program you want to view.
B. Click the program’s icon on the taskbar.
C. Click any part of the window you want to appear on front.
D. Press and hold down the <Alt> key and press the <Tab> to display the task list. Press the <Tab> key until the program you want is selected, then release the <Alt> key.

Homework

1. Click the Start button, select Programs, and click the Accessories menu.
2. Start the NotePad program (located under Programs - Accessories).
3. Make the NotePad window a few inches bigger.
4. Maximize the NotePad window.
5. Restore the NotePad window to its previous size.
6. Move the NotePad window to a different location on the screen.
7. Switch to the Calculator window.
8. Close both windows.

Quiz Answers

1. B.
2. C. The little bar along the window’s top that lists the program name is the Title bar.
3. B and D. Double-clicking the window’s Title bar or clicking the window’s Maximize button will both maximize the window so it fills the entire screen.
4. True. Clicking the icon of a minimized program on the taskbar restores the window.
5. A. Move a window by dragging its Title bar.
6. B, C, and D – you can use any of these methods to switch between open programs. Don’t use A, which starts another copy of the program instead of switching to the already open program.
Chapter Three: Customizing the Taskbar and Desktop

Chapter Objectives:

• Moving, sizing, and hiding the Taskbar
• Adjusting your computer's volume
• Adding and removing programs to and from the Start Menu
• Opening recently used files
• Starting programs with the Run command
• Adding shortcuts to the Desktop
• Starting a program automatically
• Using the Quick Launch Toolbar

When you turn on your computer and Windows loads and eventually pops to life on your screen, the first things you see are the desktop and taskbar. Not only are the desktop and taskbar the first things you see when you start Windows, but they never leave your computer at all—unless you shut it off, that is. That’s because the taskbar and desktop are two of the most important parts of Windows. The taskbar is the control center for Windows—where you start and manage all your programs. The desktop is your workspace—where you actually get your work done.

Because the taskbar and desktop are so important, this entire chapter is devoted just to them. In this chapter, you’ll learn how to customize the taskbar and desktop to set them up so they work best for you. Customizing the taskbar and desktop is a lot like arranging furniture in an empty living room—there’s no right way of doing it, just whatever works best for you.

In this chapter, you’ll learn how to move, size, and hide the taskbar, add and remove programs and folders to and from the Programs menu, and how to add shortcuts to the Windows desktop.

Prerequisites

• How to use the mouse to click, double-click, drop-and-drag, and right-click.
• How to use menus, toolbars, and dialog boxes.
• How to view and navigate through the contents of your computer (disk drives and folders.
• How to create, move, copy, and delete files and folders.
Lesson 3-1: Moving, Resizing, and Hiding the Taskbar

The taskbar is the command center for Windows, and that’s why it normally always rests along the bottom of the screen, ready for use. Still, some people think the taskbar should be located in a different, more convenient location on the screen. Others don’t like how the ever-present taskbar always occupies a half-inch of valuable desktop real estate at the bottom of the screen. This lesson will show you how to move the taskbar to a new location on the screen, how to change the size of the taskbar, and how to hide the taskbar to give you more room on the screen.

1. **Position the mouse over a blank area of the taskbar and hold down the mouse button.**

2. **Drag the taskbar to the left of your screen and release the mouse button, as shown in Figure 3-1.**

   An outline of the taskbar appears to show where you’re moving the taskbar. By dragging and dropping, you’ve moved the taskbar to the left side of the screen, as shown in Figure 3-1.
Chapter Three: Customizing the Taskbar and Desktop

NOTE: You can only move the taskbar to the top, bottom, left, or right edge of the screen.

3. Drag the taskbar back to the bottom of the screen.
   You can also change the size of the taskbar to display more or less information.

4. Position the pointer over the top edge of the taskbar, until it changes to a ↓.

5. Drag the taskbar up a half-inch and the release the mouse button, as shown in Figure 3-3.
   The taskbar is resized.

6. Drag the taskbar back to its previous size.
   You can also resize the taskbar so that it disappears entirely from the screen, although a
   tiny strip of a border of the taskbar will always appear at the bottom of the screen. If
   you can’t find you taskbar, it has either been resized until it’s almost off the screen, in
   which case you will need to resize it, or else the taskbar is hidden.

   Hide the taskbar? Yep, you can hide the taskbar to give you more room on the screen.
   When you need the taskbar, you can bring it back simply by positioning the mouse
   pointer near the bottom of the screen. Here’s how to hide the taskbar:

7. Right-click a blank area of the taskbar.
   A shortcut menu for the taskbar appears.

8. Select Properties from the shortcut menu.
   The Toolbar Properties dialog box appears, as shown in Figure 3-3.

9. Click the Auto hide option to check it, and then click OK.
   The dialog box closes and the taskbar disappears. Don’t worry—the taskbar is still
   there, it’s just hidden.

10. Position the mouse pointer near the very bottom of the screen.
    The taskbar reappears whenever the mouse pointer is near the bottom of the screen.
    When you move the mouse away from the bottom of the screen, the taskbar will
    disappear.

11. Right-click a blank area of the taskbar, select Properties from the shortcut menu, and uncheck the Auto hide option.
    Several other options appear in the Taskbar Properties dialog box. They are:
    • Always on top: Ensures that the taskbar is always visible, even when you run
      a program in full screen mode. This option is selected by default.
    • Auto hide: We’ve already gone through this option—it hides the taskbar. To
      redisplay the taskbar, position the mouse pointer near the bottom of the screen.
    • Show small icons in Start menu: Shrinks the size of the Start menu—
      useful if your Start menu contains lots of programs.
    • Show clock: Displays a digital clock on the taskbar. This option is selected by
      default.

12. Click OK.
Lesson 3-2: Adjusting your Computer’s Volume

If your computer has a sound card that is working properly, a tiny speaker will appear on the far right side of the taskbar, right next to the clock. This speaker is your computer’s volume control. This lesson will show you how you can use the speaker icon to adjust your computer’s volume—something useful to know if you have someone in your home that uses the computer to play loud, annoying computer games!

1. **Click the speaker icon, located to the far right of the taskbar, next to the clock.**
   
   The Volume control appears, as shown in Figure 3-4.

2. **Drag the volume slider up or down to increase or decrease the volume.**
   
   The Volume control also contains a Mute check box. When the Mute box is checked, the computer’s sound is turned off completely.

3. **Click anywhere outside the Volume control box.**
   
   The Volume control is usually all you need to adjust your computer’s volume. However, if you’re an audiophile, you can also fine-tune the volume settings of your computer by double-clicking the speaker icon.

4. **Double-click the speaker icon.**
   
   The Volume Control dialog box appears, as shown in Figure 3-5. The Volume Control has lots of volume and balance controls, just like an advanced, expensive stereo system. With the Volume Control dialog box, you can individually adjust the volume, balance between speakers, and input levels of your computer’s sound system. The Volume Control dialog box for your computer may have different controls, depending on the capabilities of the sound card in your computer. See Table 3-1: Controls on the Sound Control Dialog Box for a description of the various controls on the Sound Control dialog box.

5. **Close the Sound Control dialog box.**
### Quick Reference

To Adjust Your Computer’s Volume:
- Click the ![Speaker icon](speaker_icon.png) located on the far right of the taskbar and drag the volume slide control up or down.

To Turn the Volume Off:
- Click the ![Speaker icon](speaker_icon.png) located on the far right of the taskbar and check the **Mute check box**.

To Display the Volume Control Dialog Box:
- Double-click the ![Speaker icon](speaker_icon.png) located on the far right of the taskbar.

---

#### Table 3-1: Controls on the Sound Control Dialog Box

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volume Control</td>
<td>Adjusts the overall playback volume of the soundcard.</td>
</tr>
<tr>
<td>Line-In</td>
<td>Adjusts the recording volume level for the Line-In jack.</td>
</tr>
<tr>
<td>Wave</td>
<td>Adjusts the playback volume level of digitally recorded sounds, such as .wav files.</td>
</tr>
<tr>
<td>Microphone</td>
<td>Adjusts the recording volume level for a microphone.</td>
</tr>
<tr>
<td>CD Audio</td>
<td>Adjusts the playback volume level if you’re playing an audio CD in your computer.</td>
</tr>
<tr>
<td>Synthesizer</td>
<td>Adjusts the playback volume level of your sound card’s music synthesizer and MIDI files.</td>
</tr>
</tbody>
</table>
Lesson 3-3: Adding and Removing Programs to the Start Menu

Normally, when you install a Windows-based program, it automatically adds its own menu and icon to the Program menu. You can also manually add your favorite programs and files to the Program menu, making them easy to find and open.

1. **Right-click a blank area of the taskbar and select Properties from the taskbar shortcut menu.**
   
   The Taskbar Properties dialog box appears.

2. **Click the Start Menu Programs tab.**
   
   The Start Menu Program tab appears in front of the dialog box, as shown in Figure 3-6. The Customize Start menu section is what’s important here—it allows you to add and remove programs to and from the Start menu.

3. **Click Add.**
   
   The Create Shortcut dialog box appears, asking you to specify the name and location of the file you want to add to the Start menu. If you know the specific name and location of the program or file you want to add, you can type its name and location directly in the Command line text box, for example C:\WINDOWS\CDPLAYER.EXE. Most of the time you won’t know the name and location of the file and will have to browse through the contents of your computer in order to find it.

*Other Way to Add Programs to the Start Menu:*

- Locate the program file in My Computer or Windows Explorer and drag the program down to the Start button. The only problem with this method is that is places the program at the very top level of the Start Menu (although you can move it to a folder later).
4. Click the **Browse** button.
   A Browse window appears, as shown in Figure 3-7.

5. Move to the **Windows** folder in your hard disk and double-click the **Cdplayer** program file.
   Windows enter the name and location, C:\WINDOWS\CDPLAYER.EXE.

6. Click **Next**.
   The Select Program Folder window appears, as shown in Figure 3-8. Here, you must double-click the menu where you want the program to appear.

7. Double-click the **Accessories** menu folder.
   Yet another dialog box appears. Here, you can type a name you want to see on the menu since the program names aren’t always very intuitive. For example, instead of “Cdplayer” you could type “Play an Audio CD”. For now, however, we’ll just use the program name.

8. Click **Finish** and then **OK**.
   If you’ve selected an MS-DOS program, Windows will prompt you to choose an icon for the program. Windows adds the CD Player program to the accessories menu and closes the dialog box. Check to make sure it’s there.

9. Click the **Start** button, and select **Programs → Accessories** from the menu.
   Yep, there’s the Cdplayer program.

10. Click anywhere in the desktop area to close the Start menu.
    Removing an item from the Program menu is even easier than adding one, as you will see in the next few steps:

11. Right-click an empty area of the taskbar and select **Properties** from the taskbar shortcut menu, and if necessary click the **Start Menu Programs** tab.
    The Start Menu Programs tab appears in front of the Taskbar Properties dialog box.

12. Click **Remove**.
    The Remove Shortcuts/Folders dialog box appears, as shown in Figure 3-9. Here you must locate the program you want to remove from the Start menu.

13. Click the plus sign beside the **Accessories** folder to expand it.
    The Accessories folder expands and displays its contents.

14. Find and select the **Cdplayer** program under the **Accessories** folder, then click the **Remove** button.
    The Cdpplayer program is removed from the Start menu.

15. Click **Close** and then **OK**.
    Deleting a program from the Start menu doesn’t remove the program from your computer—only its **shortcut** on the Start menu. A shortcut is a quick way to start a program or open a file or folder without having to go to its actual location. Shortcuts are especially useful for programs, files, and folders you use frequently. All of the Programs in the Start Menu are actually shortcuts that point to the program files, located elsewhere on your computer. We’ll learn more about shortcuts in an upcoming lesson. You can tell the difference between a shortcut and original file because the shortcut displays an arrow (☞).

---

**Quick Reference**

**To Add a Program to the Start Menu:**

1. Right-click a blank area of the task bar and select **Properties** from the shortcut menu.
2. Click the **Start Menu Programs** tab and click **Add**.
3. Click the **Browse** button, open the program’s folder and double-click the program name.
4. Click the **Next** button, open the program’s folder and double-click the program name.

**To Remove a Program from the Start Menu:**

1. Right-click a blank area of the task bar and select **Properties** from the shortcut menu.
2. Click the **Start Menu Programs** tab and click **Remove**.
3. Open the program’s folder, select the program and click **Remove**.
4. Click **Close** and then click **Remove**.
Lesson 3-4: Organizing the Start Menu

If you only have time to read one lesson from this chapter, this is the one. Every program you install to your computer seems to add its own, individual folder to the Programs menu. Soon your Programs menu is filled with so many menus that it can be difficult find the program you want. Actually, you don’t even have to install many programs on your own to clutter up your Programs menu with zillions of folders, because most computers come set up that way!

To make your programs easier to find, you can (and should) organize your Programs menu by creating your own program folder categories, moving related programs into these new folders, and then removing any unnecessary, empty Program folders.

This lesson assumes you already know how to use Windows Explorer, create and delete folders, move files, and create and remove programs from the Start menu. If you aren’t familiar with how to do any of these tasks, you better take another look at the chapter on file management.

1. **Right-click an empty area of the taskbar, select Properties from the shortcut menu and click the Start Menu Programs tab.**
   
   The Start Menu Program tab appears in front of the Taskbar Properties dialog box.

2. **Click the Advanced button.**
   
   The contents of the Start menu appear in a hierarchical order. Since you’re using Windows Explorer, you can perform all the file management tasks you’ve learned: expand and collapse folders, create and delete folders, and move and copy files or folders.

3. **If it isn’t already expanded, click the plus sign beside the Programs folder.**
   
   The Programs folder expands.
4. Click the Programs folder, located in the left side of the window, to select it and display its contents in the right side of the windows.

The contents of the Programs folder, several folders and a program file or two, appear in the right pane of Windows Explorer. To add a new program folder to the Programs menu, to help you organize your programs, simply create a new folder inside the Programs folder.

5. Right-click an empty area in Programs folder, in the right pane, select New \rightarrow Folder from the shortcut menu, name the new folder My Stuff and press <Enter>.

Sometimes, when you create a new folder, you have to tell Windows to refresh the screen in order to display the new window.

6. Select View \rightarrow Refresh from the menu.

Windows Explorer updates the screen and displays the new My Stuff folder in both panes. Now you can add programs to your new My Stuff program folder by following the steps from the lesson on adding and removing programs, or by moving programs from other folders into the My Stuff folder.

7. Click the Accessories folder, located in the left pane, to select it and display its contents in the right side of the windows.

The contents of the Accessories folder appear in the right side of Windows Explorer. Since you’re actually using Windows Explorer to view the Start menu, you can move and copy its files and folders using the file/folder move and copy methods that you’ve already learned.

8. Drag the Calculator program from the Accessories folder (the right side of the screen) to the New Stuff folder (left side of the screen), as shown in Figure 3-11.

You’ve just moved the Calculator program. Instead of appearing in the Accessories folder it will now appear in the New Stuff folder. Close Explorer and see if this is the case.

9. Close Windows Explorer and click OK to close the Taskbar Properties dialog box.

10. Click the Start button, select Programs \rightarrow New Stuff.

Sure enough, there’s the New Stuff program folder you created with the Calculator program in it. Go back and leave the Start menu the way you left it.

11. Repeat steps 1 and 2.

You’re back in Windows Explorer, looking at the Start Menu.

12. Select the My Stuff folder (in the left pane) to select it, and drag the Calculator program from the My Stuff folder (in the right pane) to the Accessories folder (in the left pane).

Now you can delete the My Stuff folder you just emptied.

13. Click the Programs folder (in the left pane) to select it, click the My Stuff folder (in the right pane) and press the <Delete> key, and then confirm the deletion.

The My Stuff folder is deleted from the Start menu.

14. Close Windows Explorer and click OK to close the Taskbar Properties dialog box.

Other Ways to Create a Folder:
• Select File \rightarrow New \rightarrow Folder from the menu.

Quick Reference
To Organize the Programs Menu:
1. Right-click an empty area of the taskbar, select Properties from the shortcut menu and click the Start Menu Programs tab.
2. Using basic file management techniques, add new folders to the Programs Menu, as needed, and move folders and files around using drag and drop.

Or...
• Click the Start button, select Programs, then click and drag the folders or programs to the desired location in the Programs Menu.
Lesson 3-5: Opening Recently Used Documents

Windows remembers the files that you used most recently so you can quickly retrieve them, without having to dig through several browse windows. This lesson shows you how you can use the Documents option in Start menu to open a recently used file.

First, we need to create a document so Windows will be able to retrieve it.

1. Use the Notepad program to create a simple text file (type whatever you want in it) and save it in the root directory of the C: hard drive with the name Junk File, and then close Notepad.
   You learned how to save files in a previous lesson—just select File → Save from the menu and select the location where you want to save the file (the root directory of the C: drive).
   You could retrieve the Junk File by opening Notepad, and selecting File → Open from the menu. You could retrieve the Junk File by opening My Computer or Windows Explorer, opening the C: drive, and double-clicking the file. Or you could just select the Junk File from the Documents menu, as we’ll see in the next step.

2. Click the Start button and select Documents.
   The Documents menu appears, listing your recently used files, as shown in Figure 3-12. Can you find your Junk File?

3. Select the Junk File from the Documents menu.
   The Junk File opens in Notepad, where you can review and make changes to the file.

4. Close the Notepad program.
   Although there’s really no need to, you can remove the list of documents from the Documents menu.

Figure 3-12
The Documents menu keeps a listing of the files you most recently used.

Figure 3-13
Clear the Documents list in the Start Menu Programs tab of the Taskbar Properties dialog box.
5. Right-click an empty area of the taskbar and select **Properties** from the taskbar shortcut menu and click the **Start Menu Programs tab**.

The Taskbar Properties dialog box appears, as shown in Figure 3-13.

6. **Click the Clear button to remove the contents of the Documents menu.**

Initially, it appears as though nothing has happened, but Windows has removed the list of files from the Documents menu.

7. **Click OK to close the Taskbar Properties dialog box.**

Verify that the Documents menu has been reset and is empty.

8. **Click the Start button and select Documents.**

The Documents list is empty. As you create and open files, they will appear in the Documents list.

---

Quick Reference

To Open a Recent File:

- Click the Start button ➔ Documents and select the file you want to open.

To Clear the List of Recently Used Files:

1. Right-click an empty area of the taskbar, select **Properties** from the shortcut menu and click the **Start Menu Programs tab**.

2. Click **Clear** to clear the list and click **OK**.
Lesson 3-6: Adding Shortcuts to the Desktop

The Start menu makes it easy to find and open your programs. However, sometimes the 5 seconds or so it takes to wade through the menu can still be too long for opening programs or files you use frequently. A shortcut is a quick way to start a program or open a file or folder without having to go to its actual location. Shortcuts are especially useful for programs, files, and folders you use frequently. All of the Programs in the Start Menu are actually shortcuts that point to the program files, located elsewhere on your computer. Shortcuts only point to files or folders, so moving, rename, or deleting a shortcut does not affect the original program or file in anyway. You can tell the difference between a shortcut and original file because the shortcut displays an arrow (uraa).

Other Ways to Create a Shortcut:
• Right-click the file or folder for which you want to create a shortcut, and select Create Shortcut from the shortcut menu.

This lesson will show you how to add a shortcut to the desktop.

1. Open My Computer.

To create a shortcut you need to find the program you want the shortcut to point to. In this exercise, create a shortcut to the Calculator program.
2. Open the Windows folder in the (C:) hard drive.
   NOTE: The Windows folder contains the most vital program files on your computer—the ones that make Windows operate! Since you need to be extra careful when you’re opening the Windows folder, a screen like the one shown in Figure 3-15 when you open the Windows folder. Click the words Show Files to display the contents of the Windows folder.

Now, find the Calculator program—its called Calc.

3. Find the Calc program.
   There are a lot programs and files in the Windows folder, so you will have to scroll quite a bit to find the Calc program. Make sure the contents of the Windows folder are being sorted alphabetically by name—or you may never find it!

4. Using the right mouse button, drag the Calc program from the Windows folder to an empty area on your desktop.
   Dragging items with the right-mouse button causes a shortcut menu to appear, with copy, move, and create shortcut options.

5. Select Create Shortcut(s) here from the shortcut menu.
   The Calculator shortcut appears on the desktop. The default names Windows gives to shortcuts usually aren’t very meaningful, so you will usually want to rename them.

6. Rename the Shortcut to Calc shortcut Calculator.
   Remember how to rename files? Right-click the file, select Rename from the shortcut menu, rename the file and press <Enter>. Now, try using your new shortcut.

7. Double-click the Calculator shortcut.
   The Calculator program opens.

8. Close the Calculator program.
   Since a shortcut only points to a program or file, deleting a shortcut does not delete the original file it points to.

9. Delete the Calculator shortcut.
   To change the settings for a shortcut, such as what kind of window it starts in or if the location of the program changes, right click the shortcut, and select Properties. On more thing—you can create shortcuts to your favorite folders. For example, you could create a shortcut to a folder that contains your frequently used files on the Desktop (actually the My Documents is a shortcut that points to the folder My Documents located in the C: drive).
Lesson 3-7: Working with the Quick Launch Toolbar

New in Windows 98, the Quick Launch toolbar lets you add a group of buttons to the taskbar that you can use to start your favorite programs. Microsoft has already added several buttons to the Quick Launch toolbar to launch programs they think you will use frequently. The default buttons on the Quick Launch toolbar include:

- **Microsoft Internet Explorer**: This launches your Web browser, letting you surf the Internet. If you use the Internet this is a great button to have.

- **Microsoft Outlook Express**: Launches Microsoft Outlook, a program you can use to send and receive e-mail. If you use a different program to send and receive e-mail, such as America Online, you probably can safely delete this button.

- **Show Desktop**: Another great button, this one minimizes every program and window you have open at once so you can see the Windows desktop.

- **View Channels**: Of more questionable value, View Channels lets you view Internet contents that you have downloaded onto your computer. Since most people don’t use channels you can probably delete this button.

Since the taskbar always appears at the bottom of the screen, the Quick Launch toolbar is probably the fastest and most convenient place to add shortcuts to your favorite programs. There is one major caveat with the Quick Launch toolbar, however. The more buttons you add to the Quick Launch toolbar, the less room you leave on the taskbar to see what programs are currently running. You should probably never have more than six buttons on the Quick Launch toolbar.
Chapter Three: Customizing the Taskbar and Desktop

1. **Open My Computer.**
   
   The procedure of adding a program or file to the Quick Launch toolbar is almost the same as adding a shortcut to the desktop, so you need to find the program you want to add.

2. **Open the Windows folder in the (C:) hard drive.**
   
   **NOTE:** If the Windows warning screen appears when you open the Windows folder, click the words Show Files to display the contents of the Windows folder.

   Now find the Calculator program, Calc, and add it to the Quick Launch toolbar.

3. **Find the Calc program and drag it down to the Quick Launch toolbar area of the taskbar, as shown in Figure 3-16.**
   
   Since there isn’t a lot of room on the Quick Launch toolbar, you will probably have to resize it to see all of its contents. Here’s how to resize the Quick Launch Toolbar:

4. **Drag the Quick Launch toolbar’s right border to the right about a half-inch.**
   
   You’ve just resized the Quick Launch toolbar. The only problem with making the Quick Launch toolbar bigger is that you make the rest of the taskbar smaller. Try running the Calculator program from the Quick Launch toolbar.

5. **Click the Calc icon on the Quick Launch toolbar.**
   
   The Calculator program starts.

6. **Close the Calculator program.**
   
   Of course, you can always delete a shortcut from the Quick Launch toolbar if it’s no longer needed.

7. **Right-click the Calc icon on the Quick Launch toolbar and select Delete from the shortcut menu.**
   
   The Calculator shortcut is deleted from the Quick Launch toolbar.

8. **Resize the Quick Launch toolbar back to its original size.**
   
   If you don’t use the Quick Launch toolbar at all—and a lot of people don’t—you can hide it entirely and reclaim some valuable taskbar real estate.

9. **Right-click any empty area on the taskbar and select Toolbars → Quick Launch from the shortcut menu.**

   Finding an empty area on the taskbar can be difficult if you’re running several programs. If you are having trouble finding an empty area on the taskbar to right-click, you’re probably going to have to close one or more of the programs that are currently running.

   Displaying the Quick Launch tool is just as easy as hiding it.

10. **Repeat Step 9 to display the Quick Launch toolbar.**
Chapter Three Review

Lesson Summary

Moving, Sizing, and Hiding the Taskbar

- Move the taskbar by positioning the pointer over a blank area on the taskbar and clicking and dragging the taskbar to the top, bottom, left, or right of the screen.
- Change the size of the taskbar by positioning the pointer over the top edge of the taskbar, until the pointer changes to a ↓, and then dragging the edge until the taskbar is the size you want.
- Hide the taskbar by right-clicking any blank area of the taskbar, selecting **Properties** from the shortcut menu, checking the **Auto hide** option and click **OK**.
- Display a hidden taskbar by positioning the pointer near the very bottom of the screen.

Adjusting your Computer's Volume

- Adjust your computer's volume by clicking the **Speaker icon** located on the far right of the taskbar and dragging the volume slide control up or down.
- Mute your computer's volume by clicking the **Speaker icon** located on the far right of the taskbar and checking the **Mute check box**.
- **To Display the Volume Control Dialog Box:** Double-click the **Speaker icon** located on the far right of the taskbar.

Adding and Removing Programs to the Start Menu

- **To Add a Program to the Start Menu:** Right-click a blank area of the task bar and select **Properties** from the shortcut menu. Click the **Start Menu Programs tab** and click **Add**. Click the **Browse** button, open the program's folder and double-click the program name. Click **Next** button, open the program's folder and double-click the program name.
- **To Remove a Program from the Start Menu:** Right-click a blank area of the task bar and select **Properties** from the shortcut menu. Click the **Start Menu Programs tab** and click **Remove**. Open the program's folder, select the program and click **Remove**. Click **Close** and then click **OK**.
- The items in the Programs menu are only shortcuts that point to the actual program files, which are located elsewhere on your computer. Deleting a shortcut from the Programs menu doesn't delete the actual program.

Organizing the Start Menu

- You can organize your Start and Programs menus, by creating your own folders, moving related programs into these new folders, and then deleting the unnecessary, empty folders. This makes it easier to find your programs.
- **To Organize the Programs Menu:** Right-click an empty area of the taskbar, select **Properties** from the shortcut menu and click the **Start Menu Programs tab**. Using basic file management techniques, add new folders to the Programs Menu, as needed, and move folders and files around using drag and drop.
Chapter Three: Customizing the Taskbar and Desktop

- You can also organize the Programs menu by clicking the **Start button**, selecting **Programs**, then clicking and dragging the folders or programs to the desired location in the Programs Menu.

**Opening Recently Used Documents**

- You can open a recent document by clicking the **Start button** → **Documents** and selecting the file you want to open.

- **To Clear the List of Recently Used Files:** Right-click an empty area of the taskbar, select **Properties** from the shortcut menu and click the **Start Menu Programs tab**. Click **Clear** to clear the list and click **OK**.

**Using the Run Command to Start a Program**

- **To Start a Program with the Run Command:** Click the **Start button** and select **Run**. Enter the path and name of the program you want to run, or click the **Browse** button, find the file and double-click it. Click **OK** to run the program.

**Adding Shortcuts to the Desktop**

- A shortcut is a quick way to open a file or folder without having to go to the actual location. Shortcuts always display an arrow (🔗) in their corner.

- **To Create a Shortcut to a File or Folder:** Drag the file or folder to a new location with the **right mouse button** and select **Create Shortcut Here** from the shortcut menu. You can also create a shortcut by right-clicking the file or folder for which you want to create a shortcut and selecting **Create Shortcut** from the shortcut menu. Finally, you can create a shortcut by right-clicking an empty area of any folder or the Windows Desktop and selecting **New → Shortcut** from the shortcut menu, entering the path and name of the program you want the shortcut to point to.

**Starting a Program Automatically when Windows Starts**

- **To Start a Program Automatically when you Load Windows:** Add the program, file, or folder to the **StartUp** folder in the Programs Menu.

**Working with the Quick Launch Toolbar**

- **To Add an Item to the Quick Launch toolbar:** Drag and drop the object onto the Quick Launch toolbar.

- **To Resize the Quick Launch toolbar:** Drag the right border of the Quick Launch toolbar to the right or left.

- **To Delete a Program from the Quick Launch toolbar:** Right-click the program’s button on the Quick Launch toolbar and select **Delete** from the shortcut menu.

- **To Hide/Display the Quick Launch toolbar:** Right-click any empty area on the taskbar and select **Toolbars → Quick Launch** from the shortcut menu.
Quiz

1. You can move the taskbar to any edge of the screen (True or False?)

2. Which of the following statements is NOT true?
   A. You can change the size of the taskbar by dragging its top edge until the taskbar is the size you want.
   B. Move the pointer to the bottom of the screen to display a hidden taskbar.
   C. You can position the taskbar so that it floats in the middle of the screen.
   D. You can accidentally change the size of the taskbar so that it disappears almost completely from the screen – in which case you will need to resize it.

3. You can adjust your computer’s volume by clicking the speaker icon located on the taskbar and dragging the slide control up or down (True or False?)

4. Which of the following statements is NOT true (Select all that apply).
   A. You can’t add or remove programs from the Start menu.
   B. Most programs add themselves to the Start menu’s Programs menu.
   C. Deleting a program from the Start menu deletes the program from your hard disk.
   D. You can open recently used documents by clicking the Start button, selecting Documents, and selecting the file you want to open.

5. You can create, rename, delete, and move folders and files in the Start menu, just like you would in:
   A. Windows Explorer.
   B. WordPad.
   C. A Macintosh computer.
   D. The taskbar.

6. You know a program is installed on your computer, but for some reason it doesn’t appear anywhere in the Start menu. How can you start the program? (Select all that apply)
   A. Click the Start button, select Run, click the Browse button, find and double-click the file.
   B. Open My Computer, find the file and double-click it.
   C. Open Windows Explorer, find the file and double-click it.
   D. If the program doesn’t appear in the Start menu it’s not installed on your computer.

7. Which of the following statements is NOT true?
   A. Shortcuts have a in their corner.
   B. When you delete a shortcut, it also deletes the file or folder it points to.
   C. You can create a shortcut by dragging the file or folder to a new location with the right mouse button and selecting Create Shortcut Here from the shortcut menu.
   D. The items in the Start menu’s Programs menu are actually shortcuts.
Chapter Three: Customizing the Taskbar and Desktop

**Homework**

1. Position the taskbar at the top of the screen, then move it back to the bottom of the screen.
2. Display the Taskbar Properties dialog box.
3. Display the Volume control for your computer.
4. Display a list of recently used files.
5. Create a new folder in the Programs menu named "Financial Programs".
6. Delete the Financial Programs folder.
7. Use the Start menu’s Run command to start the NotePad program. (Hint: It’s located in the C:\Windows folder).
8. Create a shortcut to the NotePad program on the desktop. Delete the shortcut when you’re finished.

**Quiz Answers**

1. True. You can move the taskbar to any edge of the screen.
2. C. You can only move the taskbar to the edges of the screen.
3. True.
4. A and D. You can easily add and remove programs from the Start menu—and deleting programs from the Start menu leaves the original program intact.
5. A. Actually when you modify the Start menu’s you’re using Windows Explorer. If you picked C. My Computer you were on the right track, because you can create, rename, delete, and move folders in My Computer too.
6. A, B, and C. You can start a program or open a file using any of these methods.
7. B. A shortcut only points to a file or folder elsewhere on the computer—deleting it, moving it, or renaming it in no way affects the original file.
Chapter Four: Customizing Windows

Chapter Objectives:

- Changing the date and time
- Adding wallpaper and changing the screen colors
- Changing the screen resolution and color depth
- Using a screen saver and desktop theme
- Changing system sounds
- Adjusting the mouse
- Customizing how Windows looks and works

Prerequisites

- How to use the mouse to click, double-click, drop-and-drag, and right-click.
- How to use menus, toolbars, and dialog boxes.
- How to view and navigate through the contents of your computer (disk drives and folders).

In the old days, computers had two settings: on or off. Computers have come a long ways since then—today Windows lets you give your computer personality by changing how it looks, sounds, and operates. Click some buttons and the desktop becomes a lush jungle, with birds singing and wild animals growling. Click some more buttons and you’re working on a baseball diamond, and hear the cracking of a bat when you open a window.

This chapter will show you how to customize Windows settings to suit your own personal needs and tastes. You’ll learn how to adjust the date and time your computer thinks it is, your mouse settings so you can finally slow down that blasted double-click speed, and the sounds your computer makes. You’ll also learn how to give your computer character by adding your own custom wallpaper, screensaver, desktop themes, and screen colors. Once you’ve decorated Windows with your own personal theme, you’ll want to make sure it looks as good as possible—so you’ll learn how to adjust the screen resolution and how many colors can appear on the screen at once.
Lesson 4-1: A Look at the Control Panel

The Control Panel is the place to go when you want to change the various settings of your computer and Windows. Since this chapter deals entirely with configuring your computer, you’ll be seeing a lot of the Control Panel in the upcoming lessons. That’s why this lesson is a quick introduction to the Control Panel. No exercises here—just a guided tour of the Control Panel to help you become familiar with it.

1. **Open the Control Panel by clicking the Start button and selecting Settings → Control Panel.**

   The Control Panel appears, as shown in Figure 4-2. Your Control Panel may look slightly different, depending on your computer setup.

2. **Look at the various icons in the Control Panel and refer to Table 4-1: What’s in the Control Panel to see what they do.**

   If you’re curious, you can even go ahead and double-click any of the icons in the Control Panel to display the dialog box that lives behind each one—just don’t touch anything on those dialog boxes for now!

3. **When you’re finished, close the Control Panel.**

   Ready to start customizing your computer? Then move on to the next lesson and let’s start!

### Table 4-1: What’s in the Control Panel

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessibility Options</td>
<td>Allows you to change the settings for the mouse, keyboard, sound, and display to make the computer easier to use for those who are physically challenged.</td>
</tr>
<tr>
<td>Add New Hardware</td>
<td>Starts a Wizard that walks you through the installation of new hardware to your system, such as a network card or CD-ROM player.</td>
</tr>
<tr>
<td>Add/Remove Programs</td>
<td>Installs or removes programs and additional Windows components on your computer.</td>
</tr>
</tbody>
</table>
### Quick Reference

To Open the Control Panel:
- Click the **Start** button and select **Programs → Settings → Control Panel**.
- Or...
- Open **My Computer** and double-click the **Control Panel** folder.

<table>
<thead>
<tr>
<th><strong>Item</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Date/Time</td>
<td>Changes the date, time, and time zone information on your computer.</td>
</tr>
<tr>
<td>Display</td>
<td>Changes how your things are displayed your screen. You can adjust the resolutions, how many colors to use, the color scheme, and a lot more.</td>
</tr>
<tr>
<td>Fonts</td>
<td>Displays all the fonts that are installed on your computer, and allows you to install or remove fonts.</td>
</tr>
<tr>
<td>Game Controllers</td>
<td>This is where you can adjust your computer's joystick (if you have one).</td>
</tr>
<tr>
<td>Internet Options</td>
<td>Changes your Internet settings.</td>
</tr>
<tr>
<td>Keyboard</td>
<td>Adjusts the rate at which the cursor blinks, the rate characters are repeated when you hold down a key, and country and language settings for the keyboard.</td>
</tr>
<tr>
<td>Modems</td>
<td>Lets you see what modems are installed in your computer and what COM port they use, and adjust their properties, such as how they dial numbers.</td>
</tr>
<tr>
<td>Mouse</td>
<td>Adjusts your mouse settings, such as if the buttons are configured for a left-handed or right-handed user, double-click speed, and the speed of the mouse pointer.</td>
</tr>
<tr>
<td>Multimedia</td>
<td>Changes settings for your computer’s multimedia devices, such as the sound card’s volume and recording levels and the size of the window in which digital video plays on your computer.</td>
</tr>
<tr>
<td>Network</td>
<td>If you’re connected to a network, this allows you (or preferably your network administrator) to configure your network settings, such as the what type of network hardware, software, and protocols you’re using.</td>
</tr>
<tr>
<td>Power Management</td>
<td>Changes your computer’s power management settings, which reduces how much power your computer system uses—especially important for laptop users.</td>
</tr>
<tr>
<td>Printers</td>
<td>Displays all the printers that are currently installed for use on your computer, enables you to add and remove printers, and change each printer's default settings.</td>
</tr>
<tr>
<td>Regional Settings</td>
<td>Changes how numbers, currencies, dates and times are displayed throughout Windows.</td>
</tr>
<tr>
<td>Sounds</td>
<td>Changes system and program sounds.</td>
</tr>
<tr>
<td>System</td>
<td>Provides advanced information about your computer system and allows you to change its settings. You shouldn’t touch this one unless you really know what you’re doing.</td>
</tr>
</tbody>
</table>
Lesson 4-2: Changing the Date and Time

Your computer has its own built-in clock that has many purposes, including determining when you created or modified a file. For this reason, you should make sure the date and time are set correctly in computer. This lesson will show you how to set the date and time for your computer if you find it needs adjusting.

The far right area of the taskbar normally displays the time your computer thinks it is. To display the date, you merely need to move the pointer over the clock and wait a few seconds.

1. Move the pointer over the clock on the taskbar and wait a few seconds.
   
   A small box that displays the date appears.
   
   To change the date or time, double-click the clock on the taskbar.

2. Double-click the clock on the far right edge of the taskbar.
   
   The Date/Time Properties dialog box appears, as shown in Figure 4-3. To change the time setting, click on the area of the clock you want to adjust in the dialog box, and then click the up or down arrows.
3. Click the **hour** part of the time and click the clock’s **up-arrow** to advance the time one hour, as shown in **Figure 4-4**.

You could adjust the minutes the same way—by clicking the minute part of the time and then clicking the up or down arrows. You can also manually type the numbers in using the keyboard.

You can change the date in the right area of the dialog box. Change the month and year by clicking their corresponding text boxes, located above the calendar.

4. Click the **Month list arrow** and select **January** from the list, then click the **Year** text box and click the **up-arrow** to advance the year several years.

The calendar actually displays the days in the selected month. The current day is highlighted. To change the day, just click the day you want.

5. **Click on day 1 in the calendar, to change the date to January 1.**

If you use a laptop, you may need to adjust which time zone you’re in. You can do this using the Time Zone tab of the Date/Time Properties dialog box.

6. **Click the Time Zone tab.**

The Time Zone tab appears in the front of the dialog box, as shown in **Figure 4-5**. You can click the Time Zone list arrow to select your current time zone from a list of all available time zones. Also note the Automatically adjust clock for daylight savings changes box. When this box is checked, Windows will automatically adjust your computer’s clock when daylight saving time changes, meaning one less clock you have to change.

7. **Click Cancel to close the Date/Time Properties dialog box without applying the date and time changes you’ve made.**

The built-in clock in your computer should keep track of the date and time even when you turn your computer off. If your computer doesn’t keep the proper time and date, it means there is probably something wrong with your computer’s built-in clock.

---

**Quick Reference**

To Display the Current Date:
- Point at the **clock** on the taskbar for several seconds.

To Change the Date and/or Time:
1. Double-click the **clock** on the taskbar.
2. Adjust the date and time using the calendar and clock controls, as shown in Figure 4-4 and click **OK**.

To Change Time Zones:
1. Double-click the **clock** on the taskbar.
2. Click the **Time Zone tab** and select the time zone from the list box and click **OK**.
Lesson 4-3: Adding Wallpaper to the Desktop

Most of us don’t work in a sterile work environment—we decorate our desktops with pictures, plants, and Dilbert calendars. Similarly, Windows lets you give your computer personality to reflect your own personal tastes. In this lesson, you will learn how to start personalizing Windows by adding wallpaper to the Windows desktop. Wallpaper in Windows is a graphical picture you can stick to the desktop—the blank, background area of the Windows screen.

1. **Right-click a blank area on the desktop, and select Properties from the shortcut menu.**
   
The Display Properties dialog box appears.

2. **Click the Background tab.**
   
The Background tab appears in front of the Display Properties dialog box, as shown in Figure 4-6. This is where you can select a file to use as wallpaper.
3. **In the Wallpaper section, select the Carved Stone file from the list.**

   A preview appears of what your desktop will look like with the selected wallpaper. Notice the Display combo box—you can display your wallpaper using one of three different methods:
   - **Center:** Centers the image in the middle of your desktop. Use this setting if you have a large picture you want to display, such as a scanned picture.
   - **Tile:** Makes a repeated pattern from the image. Use this setting for small to medium sized pictures and for all the default files listed in the Wallpaper box.
   - **Stretch:** Stretches the image so that it fills the entire screen.

4. **Click the Display combo box and select Tile.**

   You’re ready to add your wallpaper.

5. **Click Apply.**

   The Carved Stone appears in a tiled pattern on your screen. If you want to use a picture that isn’t listed in the Wallpaper section, such as a scanned picture of your family, you can click the Browse button.

6. **Click the Browse button.**

   A Browse dialog box appears, asking you to specify the name and location of the file you want to use as your wallpaper.

7. **Close the Browse dialog box.**

   To remove wallpaper from your screen, just repeat steps 1 and 2, and select (None) from the Wallpaper section.

8. **In the Wallpaper section, select (Note) from the list, and then click OK.**

   The Display Properties dialog box closes, and the wallpaper is removed from the screen.

Here’s one more wallpaper tip: if you’re surfing the Web with Microsoft’s Internet Explorer (the Web browser that comes with Windows 98) and happen to see a graphic or picture you like, you can use it as your wallpaper. Just right-click the graphic and select the Set as Wallpaper option from the shortcut menu to save the image from the Internet as display it as wallpaper.
Lesson 4-4: Changing Window's Screen Colors

Another way to personalize Windows is to change the screen colors. Windows screen colors include all the basic parts of a window: the title bar, the menu, any scroll bars, etc. Windows comes with an assortment of color schemes you can use, and if you don’t like any of the color schemes, you can create your own.

1. Right-click a blank area on the desktop, and select Properties from the shortcut menu.
   The Display Properties dialog box appears.

2. Click the Appearance tab.
   The Appearance tab appears in front of the Display Properties dialog box, as shown in Figure 4-8. This is where you can change the colors of the various window elements or you can use a color scheme to change the appearance of many screen elements all at once.

3. Click the Scheme combo box and select the Desert scheme from the list.
   The preview area of the dialog box displays how your screen will look with the selected color scheme. You can also change the colors for the various windows elements. First, you need to select the item or element.

4. Click the Title bar of the Active Window in the preview area of the dialog box.
   The words “Active Title Bar” should appear in the in Item combo box. You can also select an item by selecting it from the Item combo box—but it’s more intuitive to click the item from the preview area. Next, you can change the color and the font (if it’s used) of the selected item.
5. Click the **Color** list arrow.
   A color palette appears below the Color box. Select the color you want use for the selected item.

6. **Select the Red color from the color palette.**
   The preview area of the dialog box displays the active title bar in red. To make and confirm your changes, you would normally click Apply or OK. However, since you don’t want to keep these changes for now, you can click Cancel instead.

7. **Click the Cancel button to close the Display Properties dialog box without saving any of your screen color changes.**

You can always return to the original Windows color scheme by opening the Display Properties dialog box, clicking the Appearance tab, and selecting the *Windows Standard* scheme from the scheme list.

---

**Quick Reference**

To Change Windows Color Scheme:
1. Right-click a blank area on the desktop and select **Properties** from the shortcut menu.
2. Click the **Appearance tab**.
3. Select a color scheme from the **Scheme list** and click **OK**.

To Change the Color of a Specific Windows Item:
1. Repeat Steps 1 and 2 of the previous instructions.
2. Select the item from the **Item list** or by clicking it in the **Preview area**.
3. Select a color from the color palette and click **OK**.
Lesson 4-5: Adjusting the Screen Resolution

Screen Resolution has to do with how much information can fit on the computer screen. Obviously you can’t adjust how large or small your computer’s monitor is (without buying a new one that is), but you can make all the images on your screen larger or smaller so you can see more information at once.

1. Right-click a blank area on the desktop and select Properties from the shortcut menu. The Display Properties dialog box appears.

2. Click the Settings tab. The Settings tab appears in front of the Display Properties dialog box, as shown in Figure 4-11. The Screen area is where you can change the resolution setting. Look at the numbers of pixels that are displayed—that is the current display resolution.

3. Slide the bar in the Screen area all the way to the left. The number of pixels should change to 640 by 480. If your slider is already set at 640 by 480, move the slider one notch to the right, to 800 by 600.
4. **Click Apply.**
   A dialog box, similar to the one shown in Figure 4-12 appears.

5. **Click OK to confirm the change in resolution.**
   If you’re unlucky and have an older computer, Windows may have to restart the computer to resize the screen. If you’re lucky, Windows will resize the screen without restarting your computer. Windows asks you if you like the new resolution setting, as shown in Figure 4-13. If you do like it, click the Yes button, if you don’t, click the No button. If you don’t do anything, Windows assumes you don’t like the new resolution setting, or your monitor can’t display the new resolution, and switches back to the original resolution.

6. **Click No to return to the original resolution setting.**
   For a more complete description of the various resolution settings you can use, see Table 4-2: Common Screen Resolutions. The highest resolution you can display depends on how much memory is installed on your video card. Most video cards have enough memory to display at least 800 by 600 resolution.

### Table 4-2: Common Screen Resolutions

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>640 by 480</td>
<td>This is the lowest resolution setting. 640 by 480 used to be the standard resolution setting, but larger and cheaper monitors have made it almost obsolete. Use this setting if you have a small, 14-inch (or smaller) monitor or if you have difficulty seeing information on the screen.</td>
</tr>
<tr>
<td>800 by 600</td>
<td>This is today’s standard resolution setting for most computers, and is a good in-between resolution, allowing you to display quite a bit of information on the screen without having to use a magnifying glass to read it. Use this setting if you have a 15-inch or 17-inch monitor.</td>
</tr>
<tr>
<td>1024 by 768</td>
<td>Quickly becoming the new standard, 1024 by 768 puts a lot of information on your screen, but the images can start getting small and difficult to read at this point (unless you have a large monitor). Use this setting if you have a 17-inch or greater monitor or when you want to see a lot of information at the same time, for example if you’re working a large spreadsheet, graphic files, or multiple windows.</td>
</tr>
</tbody>
</table>

Higher resolutions require more speed and video memory.

---

**Quick Reference**

To Change the Screen Resolution:
1. Right-click a blank area on the desktop and select Properties from the shortcut menu.
2. Click the Settings tab.
3. Slide the Screen Area slider to the right or left to select the resolution you want to use.
4. Click OK.
Lesson 4-6: Adjusting the Screen Color Depth

Another change you can make to your display settings is the number of colors that are displayed on the screen at once, or the color depth. Why would you want to change the number of colors displayed on your screen? Perhaps you want to use higher color depth settings to make videos and photographs more realistic. Or some finicky games also require you to use a specific color depth.

1. **Right-click a blank area on the desktop, and select Properties from the shortcut menu.**
   
The Display Properties dialog box appears.

2. **Click the Settings tab.**
   
The Settings tab appears in front of the Display Properties dialog box, as shown in Figure 4-15. The Colors combo box is where you can select the color depth you want to use. The Colors combo box displays the current color depth setting.

3. **Click the Colors combo box and select 16 Colors.**
   
   If your Color box is already set to display 16 Colors or if there isn’t a 16 Color option, then select 256 Colors.

   **NOTE:** If 16 Colors is the only option that appears in the Colors combo box it means your video card is not properly installed. You’ll need to reinstall the video drivers (software) that came along with your computer or video card.
Chapter Four: Customizing Windows

4. Click **Apply**.
   A dialog box appears, asking you confirm the changes you’ve made to the display settings.

5. Click **OK** to confirm the display setting changes.
   Windows may have to restart the computer to change the display setting. A dialog box will appear, asking you if you like the new display settings. Here again, click Yes if you want to keep the new settings and No if you want to switch back to the original color depth. If you don’t do anything, Windows assumes you don’t like the new resolution setting, or your monitor can’t display the new resolution, and switches back to the original display settings.

6. Click **No** to return to the color depth setting.

For a more complete description of the various color depth settings you can use, see Table 4-3: Common Color Depths. The maximum color depth, or simultaneous number of colors you can display at once, depends on how much memory is installed on your video card. Most video cards have enough memory to display at least High Color (16 bit) resolution.

**NOTE:** Color depths higher than High Color (16 bit) tend to slow down all but the fastest computers and video cards slightly.

### Table 4-3: Common Color Depths

<table>
<thead>
<tr>
<th>Color Depth</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>16 Colors</td>
<td>This is the lowest color depth setting, and many programs look terrible in only 16 colors. Don’t use 16 color mode unless you have a compelling reason to. If this is the only setting that appears in the Color combo box you probably don’t have the right software driver installed for your video card.</td>
</tr>
<tr>
<td>256 Colors</td>
<td>This was the standard color depth for Windows years ago, but most computers and video cards are fast enough to run with more colors without taking a performance hit.</td>
</tr>
<tr>
<td>High Color (16 bit)</td>
<td>High Color (16 bit) displays roughly 65,000 colors at once. This is the point where pictures become photo-realistic. Unless you have a new, ultra-fast computer, this is the best color depth setting because it can display photo-realistic images without slowing your computer down. You have to really squint to see much difference between High Color (16 bit) and higher levels of color depth.</td>
</tr>
<tr>
<td>True Color (24 bit) and Greater</td>
<td>True Color (24 bit) and higher display millions of colors at once. Depending on how expensive the graphics card in your computer is there may be several higher modes of color depth, which continue to display more and more colors on the screen.</td>
</tr>
</tbody>
</table>

**Quick Reference**

To Change the Screen Resolution:
1. Right-click a blank area on the desktop and select Properties from the shortcut menu.
2. Click the **Settings tab**.
3. Click the **Colors list** and select the Color Depth setting you want to use.
4. Click **OK**.
Lesson 4-7: Using a Screen Saver

A screen saver is a moving image that appears on the computer screen when you haven’t used your computer for a while. Screen savers were originally used to protect screens from screen burn, which could occur when an static image was left on the screen for hours and hours. You may have seen examples of screen burn on older cash machines. You don’t have to worry about screen burn with today’s monitors, but many people still like to use screen savers for entertainment and to personalize their computers.

This lesson will show you how make a screen saver appear if your computer hasn’t been touched for a while. You will also learn how to conserve power by having the monitor switch to a low-power standby mode or even turn itself off if the computer has been idle.

1. **Right-click a blank area on the desktop, and select Properties from the shortcut menu.**
   The Display Properties dialog box appears.

2. **Click the Screen Saver tab.**
   The Screen Saver tab appears in front of the Display Properties dialog box, as shown in Figure 4-15.

3. **Click the Screen Saver list arrow.**
   A list of the available screen savers appears.

4. **Select the Flying Windows screen saver from the list.**
   A preview of the Flying Windows screen saver appears in the preview area of the dialog box. You can also preview the screen saver in full screen mode by clicking the Preview button. You can change the settings for the selected screen saver by clicking the Settings button.
5. **Click the Settings button.**
A dialog box appears with settings for the selected screen saver. The options listed in this dialog box will differ depending on the screen saver. There may be options for how many and what type of objects should appear on the screen, how fast the objects should move, or if you want to hear sounds when the screen saver is active—it depends on which screen saver is selected.

6. **Click Cancel to close the Options for Flying Windows dialog box.**
You can assign a password to your screen saver to protect your computer from unauthorized use by clicking the Password protected check box. Windows will not clear a screen saver until this password is typed correctly.
You can easily change the amount of time it takes before Windows displays the selected screen saver.

7. **Click the Wait box and type 15.**
You can also click the Wait box up arrow until the number 15 appears. Now the screen saver will appear when you don’t use your computer for 15 minutes.
Instead of using a screen saver, if you have an Energy Star compliant monitor you can conserve power by switching the monitor to a low-power standby mode to even having the monitor turn itself off if the computer hasn’t been used for a while. Most monitors made in the last five years are Energy Star compliant.

8. **Click the Settings button in the Energy saving features of monitor section.**
The Power Management dialog box appears.

9. **Click the Turn off monitor list arrow and select After 30 minutes.**
This setting will cause your monitor to turn itself off when the computer hasn’t been used for 30 minutes. To turn the monitor back on, simply press a key on the keyboard or move the mouse—you don’t need to push the monitor’s on/off switch.

10. **Click OK.**

---

**Quick Reference**

**To Set Up a Screen Saver:**
1. Right-click a blank area on the desktop and select Properties from the shortcut menu.
2. Click the Screen Saver tab.
3. Click the Screen Saver list and select a screen saver.
4. (Optional) Specify how much time must elapse before Windows displays the selected screen saver in the Wait box and click the Password Protected check box and click Change to assign a password to the screen saver.
4. Click OK.

**To Adjust the Energy-Saving Features of your Monitor:**
1. Follow the preceding Steps 1 and 2.
2. Click the Settings button in the Energy Saving Features section and adjust the interval after which the monitor shuts off.
Lesson 4-8: Changing System and Program Sounds

Computers still have a long way to go before they can talk to you, but can give you simple audio feedback, as long as your computer has a sound card and speakers. This lesson shows you how to assign sounds to events performed on your computer. An event is an action performed by you or a program. For example, when you press an incorrect key, the computer sometimes utters a simple beep. If you have a sound card, you can choose to play a sound other than a boring beep whenever you press an incorrect key. Other events you can assign sounds to include when you start or quit Windows.

1. Open the Control Panel by clicking the Start button and selecting Settings → Control Panel.
   The Control Panel opens.

2. Double-click the Sounds icon.
   The Sounds Properties dialog box appears, as shown in Figure 4-17. The Sounds Properties dialog box displays the events to which you can assign sounds and the available sounds that you can associate with the events. There is also a number of sound schemes available that you can use to change the sounds assigned to many different system events all at once.

3. Select the Exit Windows in the Events list.
   You can listen to the sound that is currently assigned to any event by selecting the event and then clicking the triangular play button in the Preview area of the dialog box. The sound assigned to the Exit Windows event (if one is assigned) appears in the Name box.
4. **Click the Play button in the Preview area of the dialog box to listen to the sound assigned to the Exit Windows event.**

   If you don’t hear a sound, either the Exit Windows event doesn’t have a sound assigned to it (you can check this by looking at the Name box) or else your computer doesn’t have a soundcard and/or speakers, the volume is turned off, or the soundcard drivers are not installed correctly.

   To assign a different event to the selected sound, click the Browse button to select the sound.

5. **Click the Browse button.**

   A Browse window appears, as shown in Figure 4-18. Select the location and file for the sound you want to hear every time the selected event occurs.

6. **Double-click The Microsoft Sound.**

   The Microsoft Sound is now assigned to the Exit Windows event. You can listen to The Microsoft Sound by clicking the triangular play button in the Preview area of the dialog box.

7. **Click the Play button in the Preview area of the dialog box to listen to The Microsoft Sound.**

   You can quickly assign sounds to many system events at the same time by using a sound scheme. A scheme is a set of events and the sounds associated with them. Table 4-4: Common Sound Schemes lists the sound schemes that ship with Windows.

8. **Click the Schemes list arrow and select the Utopia sound scheme.**

   Windows may ask you if you want to save your current sound scheme—you can answer No to this. Now Windows will use the Utopia sound scheme for any system events.

   **NOTE:** Windows 98 may not have installed all the sound schemes during installation. To make sure all the sound schemes are installed, open the Control Panel, double-click the Add/Remove Programs icon, click the Windows Setup tab, select the Multimedia option and click Details, and make sure the Multimedia sound schemes options is checked in.

9. **Click Cancel to close the Sounds Properties dialog box without saving your changes.**

### Table 4-4: Common Sound Schemes

<table>
<thead>
<tr>
<th>Scheme</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jungle</td>
<td>Sounds you might hear in the jungle: lions roaring and bird chirping</td>
</tr>
<tr>
<td>Utopia</td>
<td>A no-nonsense scheme, with clicking, whooshing, and sliding sounds</td>
</tr>
<tr>
<td>Windows Default</td>
<td>Window's standard beep sounds (boring!)</td>
</tr>
<tr>
<td>Musica</td>
<td>Sounds you might hear in an orchestra: drums, clarinets, trumpets</td>
</tr>
<tr>
<td>Robotz</td>
<td>Industrial, mechanical sounds you might hear in some futuristic factory</td>
</tr>
</tbody>
</table>
Lesson 4-9: Using a Desktop Theme

In this chapter, you’ve learned how to customize Windows to suit your own personal tastes by changing the color scheme, sound scheme, and the desktop wallpaper. In this lesson, you’ll learn how you can change the colors, sounds, wallpaper, screen saver, mouse pointer, and icons all at once, with a desktop theme. Desktop themes are fun—they give your computer personality. Windows 98 comes with a variety of different desktop themes, including a sports theme, a nature theme, a space theme, and many more. The only downside to using a desktop theme is that they tend to slow your computer down a bit—so if you’re using an older computer you might want to reconsider before using a desktop theme.

1. Open the Control Panel by clicking the Start button and selecting Settings → Control Panel.
   The Control Panel appears.
2. **Double-click the Desktop Themes icon.**
The Desktop Themes dialog box appears, as shown in Figure 4-19.

**NOTE:** Can’t find the Desktop Themes icon in the Control Panel? It’s probably not installed. You can install desktop themes by opening the Control Panel, double-clicking Add/Remove Programs, clicking the Windows Setup tab, clicking Desktop Themes, and then clicking Details. Make sure you have the Windows 98 installation CD-ROM handy!

3. **Click the Theme list arrow to display a list of the available themes, and select the Leonardo da Vinci (256 color) option.**
A preview of the Leonardo da Vinci theme appears in the preview area of the dialog box. The wallpaper, desktop icons, colors, and sounds all reflect the selected theme.

4. **Click OK.**
The Desktop Themes dialog box closes and the Leonardo da Vinci theme is applied to the desktop, as shown in Figure 4-20.

Here’s how to return to the original desktop theme:

5. **Double-click Desktop Themes.**
The Desktop Themes dialog box reappears.

6. **Click the Theme list arrow and select Windows Default.**
This will return the desktop to its original state. Let’s take a look at one more thing before you close the dialog box: the Settings section. The Settings section of the Desktop Theme dialog box lets you apply a theme to only selected settings. For example, you could apply a theme’s screen saver, desktop wallpaper, colors, and icons, but nothing else.

7. **Click OK to close the Desktop Themes dialog box.**
Lesson 4-10: Adjusting the Mouse

A common complaint many users have about Windows is they don’t like how the mouse works. The mouse either is too slow or too fast, does not respond very well to your double-clicks, or worst of all, if you’re left handed its buttons are in the wrong places!

This lesson shows you how to adjust the mouse settings to make it easier for you to work with.

1. Open the Control Panel by clicking the **Start button** and selecting **Settings → Control Panel**.
   The Control Panel opens.

2. **Double-click the Mouse** icon to change the mouse settings.
   The Buttons tab of the Mouse Properties dialog box appears, as shown in Figure 4-21.
   Many people complain that the double-click speed setting for Windows is too fast. To adjust the amount of time between clicks, drag the Double-click speed slider to the right or left. You can test the double-click speed by double-clicking the jack-in-the-box in the Test area box.
3. **Slide the Double-click slider to Slow**, and then double-click the jack-in-the-box in the **Test area**.
   
   Jack jumps out of his box when you complete a successful double-click.

4. **Slide the Double-click slider to Fast**, and then double-click the jack-in-the-box in the **Test area**.
   
   You probably won’t be able to double-click fast enough to make Jack go in or out of his box with the double-click setting this fast.

   You will have to experiment with the Double-click slider, adjusting it to find a double-click speed that suits your own personal preferences. Most people find that the double-click speed works best somewhere in the middle or somewhat to the left of the Double-click speed bar.

5. **Click the Motion tab**.
   
   The Motion tab of the Mouse Properties dialog box appears, as shown in Figure 4-22. Here you can also adjust how fast the mouse pointer moves across your screen when you move the mouse by dragging the Pointer speed slider to the right or left.

   Also on the Motion tab is the Pointer trail option. Click the Show pointer trails check box if you have a laptop and find it difficult to see the pointer. A long trail will follow the mouse pointer as you move it, making the mouse easier to spot on LCD laptop screens.

   Now that you understand how to adjust the mouse to your liking, you can close the Mouse Properties dialog box to end the lesson.

6. **Click Cancel** to close the Mouse Properties dialog box without saving your changes.
Chapter Four Review

Lesson Summary

A Look at the Control Panel

- The Control Panel is where you can change the various settings of your computer and Windows.
- Open Control Panel by clicking the Start button and selecting Programs → Settings → Control Panel, or by opening My Computer and double-clicking the Control Panel folder.

Changing the Date and Time

- Point at the clock on the taskbar for several seconds to display the current date.
- **To Change the Date and/or Time:** Double-click the clock on the taskbar, adjust the date and time using the calendar and clock controls, and click OK.
- **To Change Time Zones:** Double-click the clock on the taskbar, click the Time Zone tab, select the time zone from the list box, and click OK.

Adding Wallpaper to the Desktop

- **To Add or Change Wallpaper:** Right-click a blank area on the desktop and select Properties from the shortcut menu. Make sure the Background tab is selected, and then select the wallpaper you want to use from the preset list or click Browse and specify the name and location of your own picture or graphic you want to use as wallpaper. Select how you want the wallpaper to be displayed (centered, tiled, or stretched) from the Display list and click OK.

Changing Window's Screen Colors

- **To Change Windows Color Scheme:** Right-click a blank area on the desktop and select Properties from the shortcut menu, click the Appearance tab, select a color scheme from the Scheme list and click OK.
- You can change the color of a specific Windows object (such as the Title bar) by opening the Appearance tab of the Display Properties dialog box, clicking the object in the Preview area or select it from the Item list, specifying its color from the color palette, and clicking OK.

Adjusting the Screen Resolution

- Screen Resolution has to do with how much information can fit on the screen. Higher screen resolutions can display more information on the screen at once, but at the price of making everything appear smaller.
- **To Change the Screen Resolution:** Right-click a blank area on the desktop and select Properties from the shortcut menu, and click the Settings tab. Slide the Screen Area slider to the right or left to select the resolution you want to use, and click OK.
Adjusting the Screen Color Depth

- Color depth has to do with how many colors are displayed on the screen at the same time.
- **To Change the Screen Resolution:** Right-click a blank area on the desktop and select Properties from the shortcut menu, click the Settings tab, click the Colors list and select the Color Depth setting you want to use, and click **OK**.

Using a Screen Saver

- **To Set Up a Screen Saver:** Right-click a blank area on the desktop and select Properties from the shortcut menu, click the Screen Saver list and select a screen saver, and click **OK**.
- You can password protect your screen saver by clicking the Password Protected check box and clicking **Change** to assign a password to the screen saver.
- You can adjust the energy-saving features of your monitor by opening the Screen Saver tab of the Display Properties dialog box, clicking the **Settings button** in the Energy Saving Features section, and adjusting the interval after which the monitor shuts off.

Changing System and Program Sounds

- **To Use a Sound Scheme:** Click the Start button and click **Settings → Control Panel**, double-click the Sounds icon, select a scheme from the Schemes list, and click **OK**.
- **To Assign a Sound to a Specific Windows Event:** Click the Start button, select **Settings → Control Panel** and double-click the Sounds icon. Select the event for which you want to assign a sound, then click the **Browse button** and specify the location and name of the sound file you want to assign to the event. Click the **Play button** to listen to the selected sound, and click **OK**.

Using a Desktop Theme

- **To Use a Desktop Theme:** Click the Start button, select **Settings → Control Panel**, double-click the Desktop Themes icon and select a theme. (Optional) check each setting to which you want the theme applied, and click **OK**.
- The Desktop Themes is an optional Windows component. If you can't find it, you'll need to install it by opening the Control Panel, double-clicking Add/Remove Programs, clicking the Windows Setup tab, and check the Desktop Themes box.

Adjusting the Mouse

- Open the Mouse Properties dialog box by clicking the Start button, select **Settings → Control Panel** and double-clicking the Mouse icon.
- **To Switch the Left and Right Mouse Buttons:** Open the Mouse Properties dialog box, select either the **Right-handed** or **Left-handed** option and click **OK**.
- **To Change the Double-Click Speed:** Open the Mouse Properties dialog box, drag the **Pointer Speed slider** to a new position, and click **OK**.
- **To Change the Pointer Speed:** Open the Mouse Properties dialog box, click the **Motion tab**, drag the **Pointer Speed slider** to a new position, and click **OK**.
- **To Add Pointer Trails:** Open the Mouse Properties dialog box, click the **Motion tab**, click the **Show pointer trails box** and click **OK**.
Viewing and Working with Windows as a Web Page

- Windows 98 lets you view and work with the desktop, folders, and files like a Web page (Web Style) or like Windows 95 (Classic Style).
- In Web Style, Windows looks and works just like a Web page. Single-click items on your desktop or in folders just once to open or run them, just like you click links on the Web. To select an item, you just point to it.
- In Classic Style, Windows looks and works the way it always has. Double-click items on the desktop or in a folder to open or run them, and single-click to select them.
- To Switch between Classic Style and Web Style: Click the Start button and select Settings → Folder Options, Select one of the three options (Web style, Classic style, or Custom) and click OK.

Customizing How Folders Look and Work

- To Customize how Folders Works: Click the Start button and select Settings → Folder Options.

Customizing Folder View Options

- To Customize Folder View Options: Click the Start button and select Settings → Folder Options, click the View tab, select the desired folder view options, and click OK.

Quiz

1. Used only for advanced networking settings, the Control Panel should never be touched by ordinary users (True or False?)

2. Which of the following statements is NOT true?
   A. You can change the color of individual Windows objects, such as the title bar and scroll bars.
   B. You can change the colors for all Windows objects at once using a color scheme.
   C. Double-click the clock on the taskbar to adjust the time and date your computer thinks it is.
   D. You can only use preset patterns as your desktop wallpaper.

3. 640 x 480, 800 x 600, 1024 x 768 are all examples of:
   A. Color depths.
   B. Dimensions for the three largest patios in the world.
   C. Screen resolutions.
   D. Multiplication problems that you would need to use a calculator to solve.
4. You’re a huge fan of the early 1980’s TV show “The Dukes of Hazard.” Which of the following are ways you could customize your computer to show everyone your devotion to this forgotten show?

A. Change the desktop wallpaper to a confederate flag, like the paint job on the Duke boy’s car.
B. Apply the “The Dukes of Hazard” desktop theme, which comes with Windows 98.
C. Add a system sound so that whenever someone turns your computer on they hear sheriff Roscoe exclaim “Them Dukes, them Dukes!”
D. Windows 98 doesn’t allow you to personalize your computer in such bad taste.

5. You can change the mouse’s double-click speed by clicking the Mouse icon in the Control Panel (True or False?)

6. Which of the following is a major difference between Windows 95 and Windows 98?

A. File names in Windows 98 can contain up to 256 characters instead of only 8 characters in Windows 95.
B. Windows 98 responds to voice commands.
C. Windows 98 gives you the option of viewing and working with the contents of your computer like a Web page.
D. Windows 95 requires 8 MB of RAM while Windows 98 only requires 2 MB of RAM.

7. Double-clicking the desktop opens the Display Properties dialog box, which allows you to change any screen settings, such as the Windows colors, screen resolution, and desktop wallpaper (True or False?)

Homework

1. Change your Windows wallpaper to Leaves, in tiled format.
2. Change your Windows screen colors to the Desert color scheme and then back to the previous color scheme.
3. Change the Windows sound scheme to the Musica scheme, and then back to the previous sound scheme.
4. Try out your video card’s various screen resolutions to see which one you like best.
5. Try viewing and working with My Computer or Windows Explorer using Web Style. Switch back to Classic Style when you’re finished.
6. Adjust your mouse’s pointer speed and double-click speed to suit your preferences.

Quiz Answers

1. False. The Control Panel is where you go to make changes to Windows and your computer. While there are a few technical areas in the Control Panel, most of it is straightforward and easy to understand.
2. D. You can use your own pictures and graphics as wallpaper in addition to Windows preset wallpaper settings.
3. C. These are all examples of screen resolutions.

4. A and C. Fortunately there isn’t a Duke of Hazard desktop theme that ships with Windows 98, but you can still personalize the other settings, such as the wallpaper and system sounds.

5. True. The double-click speed is probably one of the first things you should adjust if you’re having trouble double-clicking with the mouse.

6. C. Windows 98 lets you view and work with your computer in Web style and Classic style—something Windows 95 didn’t offer (unless you installed Microsoft Internet Explorer 4.0 or later).

7. False. Right-click the desktop and select Properties from the shortcut menu to open the Display Properties dialog box.